Medicare Remit Easy Print
User Guide
Version 4.6

January 2018
This software was developed by the Centers for Medicare & Medicaid Services (CMS) for use by Medicare providers/suppliers to view and print a Health Insurance Portability and Accountability Act (HIPAA) compliant Medicare 835. Medicare has no liability and takes no responsibility for any other use of this software.

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS) under contract HHSN-316-2012-00023W / HHSM-500-2016-00005U – DME Shared System Maintenance

This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
Table of Contents

Table of Contents ........................................................................................................... 1
About Medicare Remit Easy Print .................................................................................. 4
Informational .................................................................................................................. 4
What’s New .................................................................................................................... 4
Differences between MREP Remittance Advices and Shared System ERAs ............... 5
About This Guide .......................................................................................................... 6
Need Assistance? ........................................................................................................... 6
PC Requirements .......................................................................................................... 6
Operating System Requirements .................................................................................. 7
How Does Medicare Remit Easy Print Get Medicare Remittance Info? ..................... 9
Information for Administrators ..................................................................................... 9
Network Installations ..................................................................................................... 9
  Pre-Installation Checklist for Installation on a Network .............................................. 10
  Installing Medicare Remit Easy Print on a Network ................................................... 11
    Before You Install Medicare Remit Easy Print on a Network ................................ 11
    How to Install Medicare Remit Easy Print on the Network .................................... 11
  Installing the Medicare Remit Easy Print Group Code on a PC ............................... 15
    How to Install the Medicare Remit Easy Print Group Code .................................. 15
    How to Know that the Medicare Remit Easy Print Group Code Install Completed Successfully ..... 15
PC Installations .............................................................................................................. 17
  Getting Started ........................................................................................................... 17
  Pre-Installation Checklist for Installation on a PC ..................................................... 18
  Installing Medicare Remit Easy Print ........................................................................ 19
    Before You Install Medicare Remit Easy Print ...................................................... 19
    How to Install Medicare Remit Easy Print on Your PC ....................................... 19
  Starting Medicare Remit Easy Print ......................................................................... 24
    Before You Start Medicare Remit Easy Print ....................................................... 24
    How to Start Medicare Remit Easy Print ............................................................ 24
Locating MREP and MREP File Locations on Your PC/Network ................................. 28
  Locating the MREP Application on Your PC/Network – Icon Available ............... 28
  Locating the MREP Application on Your PC/Network – Icon not Available .......... 30
  Identifying Easy Print File Locations ..................................................................... 32
Uninstalling Medicare Remit EasyPrint ........................................................................ 35
Online Help System ...................................................................................................... 37
  How to Access the Online Help System ................................................................. 37
    How to Use the Contents Tab ............................................................................. 39
    How to Use the Index Tab ................................................................................. 41

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-00023W / HHSM-500-2016-00055U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
How to Use the Search Tab .............................................................. 42
How to Close the Medicare Remit Easy Print Help Window .................. 43

Importing HIPAA 835 files .................................................................. 44
Before You Import the HIPAA 835 File ............................................. 44
Import File Name Format .................................................................... 44
How to Import the HIPAA 835 File ....................................................... 45
How to Automatically Import the HIPAA 835 File ............................... 47
What to Do with an Import Error Message ......................................... 50
Import Exception Summary Window/Report ........................................ 51

Working with MREP Remittance Advices ........................................... 53
How to View a List of Claims for an MREP Remittance Advice .......... 53
How to View the Detail for a Claim ..................................................... 55
How to View the Total Amounts for a Remittance Advice .................. 59
How to View the Data in the Import File ............................................. 61
How to View the CARC and RARC Codes ......................................... 63
How to Look up a CARC/RARC Code, Group Code, or CORE Business Scenario .......................................................... 65
How to Update (Import) the CARC/RARC Codes, Group Codes, and CORE Business Scenarios ................................................. 66
How to Print a List of Claims .............................................................. 70
How to Print the Detail for a Claim ..................................................... 72
How to Print the Remittance Advice Summary ................................... 74
Searching Payment Information ........................................................ 76
  How to Search Payment Information .............................................. 77
Making Sense of the Claim List Tab .................................................... 81
  Display Claim(s) ........................................................................... 83
Making Sense of the Claim Detail Tab ................................................... 85
Making Sense of the Remit Summary Tab ............................................. 88
Making Sense of the Data View Tab ..................................................... 90
Making Sense of the Search Tab ......................................................... 91
Making Sense of the Glossary Tab ...................................................... 92

Working with Reports ........................................................................ 93
Making Sense of the Denied Service Lines Report ............................... 94
Making Sense of the Adjusted Service Lines Report ............................ 95
Making Sense of the Deductible Service Lines Report .......................... 96
Making Sense of the Coinsurance Service Lines Report ....................... 97
Making Sense of the Deductible/Coinsurance Service Lines Report ........ 98
Making Sense of the COB Claims Report ........................................... 99
Making Sense of the Non-COB Claims Report ..................................... 100
Making Sense of the MSP Claims Report .......................................... 101

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-00023W / HHSM-500-2016-0005SU – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
About Medicare Remit Easy Print

Medicare Remit Easy Print enables you to print Medicare Part B and DME MAC HIPAA 835v5010 files in a format that is similar to the Electronic Remittance Advice (ERAs). You can use Medicare Remit Easy Print to:

- view MREP Remittance Advices (see page 53)
- search MREP Remittance Advices (see page 77)
- print MREP Remittance Advices (see page 200)
- print reports about MREP Remittance Advices (see page 105)

You can install Medicare Remit Easy Print on a PC or on a network (see Pre-Installation Checklist for Installation on a PC).


Informational

- MREP accepts remittances in the X12 835V5010A1 and X12 835V4010A1 formats. MREP no longer accepts remittances in the X12 835V5010 format. Since the X12 835V5010 format was only used during the transition period from X12 835V4010A1 and was never used in production, the user guide refers to the X12 835V5010A1 format as X12 835V5010.

- MREP Version 4.6 includes the CARC and RARC lists published by the WPC (Washington Publishing Company) as of 7/3/2017 and Code Combination Business Scenarios published by the CAQH/CORE in October 2017 (spreadsheet v.3.4.1). Future lists will be made available individually and can be imported into MREP to keep the codes current. For more information, see How to View the CARC and RARC Codes.

What’s New

- As CMS moves from using HICNs for patient identification to using Medicare Beneficiary Identification (MBI) numbers, MREP screens and reports are being updated, changing headers and labels from HICN or HIC to MID (Medicare Identification number). The MID field could be populated with a HICN or an MBI. The primary MID will be populated with the Submitted ID (2100 NM109 value when 2100 NM101 = QC). If an alternate MID is transmitted in the 835 Corrected Patient ID Segment (2100 NM109 value when 2100 NM101 = 74), it appears below the primary MID. A MID can be a HICN or a MBI. Note: When viewing historical 4010A1 remittances, a Corrected Patient ID will continue to replace the Submitted Patient ID.
Differences between MREP Remittance Advices and Shared System ERAs

It is important to understand that the Medicare Remit Easy Print Remittance Advice is a representation of the HIPAA 835v4010A1 or the HIPAA 835v5010 transaction data. Although CMS attempted to make the Medicare Remit Easy Print generated Remittance Advice very similar to the Shared System Maintainer generated SPR (received by mail), the printed information and data content at times may differ. So, the two can be compared as long as there is an understanding of why they differ.

For example, the HIPAA 835v5010 transaction data contains reversal (mother) claim information and, in turn, the Medicare Remit Easy Print Remittance Advice displays this information and uses it in the calculation of the entire remittance total. The CMS systems that create the file for the SPR received by mail have the ability to net the claim information for adjustments prior to generating the SPR. The HIPAA 5010 transaction has no facility to convey the information to allow MREP to net the claim information for adjustments prior to generating the Medicare Remit Easy Print Remittance Advice and, therefore, must do a complete back-out of the original claim and build a new adjusted claim with the modified information.

<table>
<thead>
<tr>
<th>Item</th>
<th>Medicare Remit Easy Print</th>
<th>Shared System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustments</td>
<td>You must calculate the net.</td>
<td>The net was calculated for you.</td>
</tr>
<tr>
<td></td>
<td>Claim Example #1</td>
<td></td>
</tr>
<tr>
<td>Original Claim</td>
<td>00000000000000001000</td>
<td>Claim Example #1</td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$100.00</td>
<td>Adjustment Claim $000000000001001</td>
</tr>
<tr>
<td>Adjustment Claim</td>
<td>0000000000000100</td>
<td>Provider Paid $20.00</td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$80.00</td>
<td>Claim Example #2</td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$20.00 (overpayment)</td>
<td>Adjustment Claim $000000000002001</td>
</tr>
<tr>
<td></td>
<td>Claim Example #2</td>
<td>Provider Paid $50.00</td>
</tr>
<tr>
<td>Original Claim</td>
<td>0000000000000200</td>
<td></td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Adjustment Claim</td>
<td>0000000000000200</td>
<td></td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$150.00</td>
<td></td>
</tr>
<tr>
<td>Provider Paid</td>
<td>$50.00 (underpayment)</td>
<td></td>
</tr>
<tr>
<td>PREV PD</td>
<td>Always blank</td>
<td>Calculated for you</td>
</tr>
<tr>
<td>General Messages</td>
<td>Not shown</td>
<td>Shown</td>
</tr>
<tr>
<td>for Suppliers/</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Providers (Provider</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bulletin Board)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About This Guide

All personal health information has been replaced with fictitious information.

To use this guide, you need to have a working knowledge of Microsoft Windows.

For example, you need to know how to:

- access your desktop,
- use the Start menu, and
- use Microsoft Windows Explorer.

You also need to know common Microsoft Windows terminology. For example, Start > Programs refers to the Programs option on the Start menu.

Need Assistance?

If you need assistance, please contact:

Email  Your Medicare contractor
Phone  Your Medicare contractor

PC Requirements

- **Recommended Speed:** 2.0 gigahertz (GHz) or faster
- **RAM (Random Access Memory):** 256 megabytes (Mb) or above
- **Hard Disk Space:** 1 gigabyte (GB)
- **Display:** 1024x768 High Color (16-bit)
Operating System Requirements

**Recommended:** Windows 7

**.NET Framework:** 2.0 SP2

This application uses Visual Basic.Net, a Microsoft compatible language and, like many applications that require an MS Windows platform, MREP requires a .NET framework. More than likely one or more .NET frameworks were pre-installed on your Windows operating system or Windows Update downloaded a newer version on your PC. You must have .NET framework version 2.0 SP2 on each PC using the MREP Application.

**Note:** .NET frameworks 3.0, 3.5, and 4.0 include the 2.0 SP2 framework so if one of these frameworks is present, .NET 2.0 SP2 does not need to be installed separately. Windows 8 users may need to install or enable the .NET 3.5 framework 3.5 on each PC that uses MREP.

If you do not have the necessary framework installed, you may receive a message stating that this version of the framework is required during the installation process and prompting you to install it.

By clicking Yes—and if you have access to the Internet—you are redirected to the Microsoft web site to download the .NET framework 2.0 SP. Download NetFx20SP2_x86.exe for 32-bit systems or NetFx20SP2_64.exe for 64-bit systems. We do not recommend that you download a beta version of the .NET framework if you are presented with this option on the Microsoft web site.

Outside of the application installation process, you may also visit the link to Microsoft .NET Framework Version 2.0 Service Pack 2 at the Microsoft website to transport directly to the location on the Microsoft web site to download the 2.0 SP2 .NET framework version.

If you want to learn more about the 2.0 SP2 .NET Framework version and/or determine if you need to install this version, you may visit .Net Framework Developer Center at the Microsoft website.

Please follow the directions within the web site when using this link.

If you do not have access to the Internet and you receive a message to update your .NET framework, you have to obtain a copy of the .NET framework from Microsoft. The Medicare Remit Easy Print application does not work without the appropriate .NET framework installed on each machine accessing the application.
Decompression Application: To download the Medicare Remit Easy Print program from your Medicare contractor's web site, you must have the following:

- Access to the Internet.
- 7-Zip, WinZip, or a compatible decompression application to extract files. If you do not have a decompression application, you can go to a number of web sites to acquire one (For example: http://www.winzip.com/downwzeval.htm).
How Does Medicare Remit Easy Print Get Medicare Remittance Info?

You have to import Medicare remittance information into Medicare Remit Easy Print. For more information about importing, see Importing HIPAA 835 files.

The files that you import are the ANSI files. For more information about the format of these files, see Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk.

When Medicare Remit Easy Print reformats and saves a copy of an HIPAA 835 file, it is called the Import file. For information about how EasyPrint names the Import files, see Import File Name Format.

Medicare Remit Easy Print keeps all of the Import files in the Import folder in the Medicare Remit EasyPrint directory.

Information for Administrators

Medicare Remit Easy Print can be installed on a PC or network.

To install MREP:
- on a PC, see PC Installations
- on a network, see Installing Medicare Remit Easy Print on a Network

Network Installations

Medicare Remit Easy Print Directory

There must be sufficient space on the network to save the Import file(s).

The Medicare Remit Easy Print software takes about 4000 KB.

Users must have Read/Write access to the directory where the software is installed because the software creates files and saves them using the user’s security privileges to the directory.

Medicare Remit Easy Print Access

If you need to make Medicare Remit Easy Print available to all users who log on, indicate this during the installation procedure.

Group Code MSI file

When installing the application on a network, each PC that accesses the application must have installed the Group Code MSI file.
Pre-Installation Checklist for Installation on a Network

Before you install Medicare Remit Easy Print, you need to complete these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Check that the network, all PCs, and printers meet all requirements.</td>
<td>✔️</td>
</tr>
</tbody>
</table>
| 2    | Find out where to save the Medicare Remit Easy Print installation software on your C:\ drive or Desktop.  
   The file name is: Medicare Remit Easy Print.msi  
   Write the location here: | |
| 3    | Find out where to save the Medicare Remit Easy Print Group Code .msi file on your C:\ drive or Desktop:  
   The file name is: GroupCode.msi  
   Write the location here:  
   Note: The GroupCode.msi must be installed on all PCs executing EasyPrint from a network location or any PCs that access network locations from within the application.  
   When installed on a network drive, only the EasyPrint shortcut and the GroupCode.msi package need to be installed on PCs executing the application. There is no need to install the application on each individual PC.  
   To ensure each client PC can access the application: from the client PC, navigate to the network location where Medicare Remit Easy Print is installed, right click on the EasyPrint.exe file, and select “create shortcut”. This shortcut can then be copied to the desktop of the client PC. This step is necessary in the event the network drive mapping is different on the client PC. | |
| 4    | Create a folder called HIPAA 835 files and make sure that all users know the location.  
   This folder must have adequate security for PHI.  
   Write the location for the HIPAA 835 files here: | |
| 5    | Create a directory on the server for the Medicare Remit Easy Print installation.  
   This directory must have adequate security for PHI. | |
Installing Medicare Remit Easy Print on a Network

When you install Medicare Remit Easy Print on a network:

- install Medicare Remit Easy Print on the network
- install the Medicare Remit Easy Print Group Code on every PC accessing the application

Before You Install Medicare Remit Easy Print on a Network

Before you install Medicare Remit Easy Print:

- complete the Pre-Installation Checklist for Installation on a Network

How to Install Medicare Remit Easy Print on the Network

**Important!**
If this download cannot get past your network firewall, please contact your Medicare contractor.

**Download Instructions**


1. Select the Medicare Remit Easy Print link.
2. Click the Medicare Remit Easy Print zip file. Depending on your browser, the file saves to your Downloads folder or you can save the file to the location you noted on the Pre-Installation Checklist for Installation on a Network.
3. Double click the .zip file.
Installation Instructions

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 2 of the Pre-Installation Checklist for Installation on a Network.)

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.

3. Double-click the Medicare Remit Easy Print.msi file:

   ![Security Warning]

   **The publisher could not be verified. Are you sure you want to run this software?**

   **Name:** C:\Users\lisa.mandel\AppData\Local\Temp1\Test\EasyPrintM3 (3).zip\Medicare Remit Easy Print.msi

   **Publisher:** Unknown Publisher

   **Type:** Windows Installer Package

   **From:** C:\Users\lisa.mandel\AppData\Local\Temp1\Test\EasyPrintM3 (3). zip

5. Click Next.

The Select Installation Folder window opens.

6. Click Browse to find the network location for the install. The applications and associated files will download to that location.

7. On the following line, write the location where you are saving the application and where all of the associated folders and files are to be saved:

________________________________________________________

Note: Do not install Easy Print in the C:\Program Files directory.

8. Select Everyone and click Next.
The Confirm Installation window opens.

9. Click Next.

When the installation finishes\(^1\), the Installation Complete window opens.\(^2\)

10. Click Close.

---

\(^1\) **Important!**
You must install the Medicare Remit Easy Print Group Codes on each PC.

\(^2\) **Best Practice:**
Make the shortcut to the Medicare Remit Easy Print executable available to all users.

What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the Medicare Remit Easy Print folder in Step 6 of the Installation Instructions:

- EasyPrint.exe
- Easy Print icon - shortcut
- Import folder – location of active converted HIPAA 835 files
- Archive folder – location of inactive converted HIPAA 835 files. Inactive files are files not currently viewed in the application.
- Native 835 folder – default location from which to import 835 files
- Report Export folder - where exported Report files are stored
- Resource folder - internal folder to application

Installing the Medicare Remit Easy Print Group Code on a PC

After you install the Medicare Remit Easy Print application on the network, you must install the GroupCode.msi file on every PC that needs to access the application.

How to Install the Medicare Remit Easy Print Group Code

1. Make sure you know the location of the Medicare Remit Easy Print Group Code file (Step 3 of the Pre-Installation Checklist for Installation on a PC).

The installation completes without opening any windows or displaying any messages.

How to Know that the Medicare Remit Easy Print Group Code Install Completed Successfully

If the installation DID complete successfully, the PC user can open Medicare Remit Easy Print.

If the installation DID NOT complete successfully, the PC user cannot open Medicare Remit Easy Print and sees this unhandled exception dialog box.3

3 Hint: If you see this error message on the PC, you need to install the Medicare Remit Easy Print Group Code. You need a minimum screen resolution of 1024 X 768.
Click OK and install the Medicare Remit Easy Print Group Code again.
HIPAA 835 File Location

Users must know the location from which to download the HIPAA 835 file they receive from their Medicare contractor.

Medicare Remit Easy Print Directory

There must be sufficient space on the PC for Medicare Remit Easy Print to save the Import file(s).

The Medicare Remit Easy Print software takes about 4000 KB. The size of the Import file(s) is dependent upon the number of claims found in the HIPAA 835 file.

Medicare Remit Easy Print Access

The default for installing Medicare Remit Easy Print is to have it be accessible only to a single user on a PC.

Getting Started

To get started:

1. Complete the Pre-Installation Checklist for Installation on a PC.
2. Install Medicare Remit Easy Print on your PC (see page 19).

Best Practice: Create a folder called HIPAA 835 files to store your 835 files, and make sure that all users know the location.
### Pre-Installation Checklist for Installation on a PC

Before you install Medicare Remit Easy Print, you need to complete these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Check to be sure that your PC and printer meet all requirements.</td>
<td>✓</td>
</tr>
</tbody>
</table>
| 2    | Find out where to save the Medicare Remit Easy Print install file. The file name is: Medicare Remit Easy Print.msi  
Write the location here: ________________________________ | No data    |
| 3    | Find out where to save the HIPAA 835 files.  
Write the location here: ________________________________ | No data    |
| 4    | The default installation location is C:\Medicare Remit EasyPrint. If you want to install the application in another location, create a directory on the PC for the Medicare Remit EasyPrint installation. This directory must have adequate security for PHI.  
**Note:** Do not install Easy Print into the C:\Program Files directory. | No data    |
Installing Medicare Remit Easy Print

Before You Install Medicare Remit Easy Print

Before you install Medicare Remit Easy Print:

Complete the Pre-Installation Checklist for Installation on a PC

How to Install Medicare Remit Easy Print on Your PC

Download Instructions

From the CMS website: https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/AccessDataApplication/MedicareRemitEasyPrint.html:

1. Select the Medicare Remit Easy Print link.
2. Click the Medicare Remit Easy Print zip file. Depending on your browser, the file saves to your Downloads folder or you can save the file to the location you noted on the Pre-Installation Checklist for Installation on a PC.
3. Double click the .zip file.

5 Important!

If this download cannot get past your PC security settings, please contact your Medicare carrier.
Installation Instructions

4. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 2 of the Pre-Installation Checklist for Installation on a PC)

5. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.

6. Double-click the Medicare Remit Easy Print.msi file:

![Security Warning](security_warning.png)


![Setup Wizard](setup_wizard.png)

8. Click Next.
The Select Installation Folder window opens.

![Select Installation Folder](image)

9. If you want to accept the default installation location, click Next. To install in another location, click Browse to find the location for the install. The applications are downloaded to the location you selected.

10. On the following line, write the location where you are saving the application and where all of the associated folders and files are to be saved:

```
________________________________________________________
```

**Note:** Do not install Easy Print in the C:\Program Files directory.

11. Select Everyone and click Next.

![Confirm Installation](image)

The Confirm Installation window opens.
12. Click Next.

When the installation finishes, the Installation Complete window opens.

13. Click Close.

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print directory. Copy this shortcut to your desktop.
What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the Medicare Remit Easy Print folder in Step 4 of the Installation Instructions:

- EasyPrint.exe
- Easy Print icon (shortcut)
- Import folder (location of active converted 835 files)
- Archive folder (location of active converted 835 files. Inactive files are files not currently viewed in the application.
- Native 835 folder (default location from which to import 835 files)
- Report Export folder (where all exported Report files are stored)
- Resource folder (internal folder to application)
Starting Medicare Remit Easy Print

You can find shortcuts to the Medicare Remit Easy Print program in 2 places:

- Your PC desktop:
- The Start > Programs menu:

Before You Start Medicare Remit Easy Print

Before you start Medicare Remit Easy Print, you must:

- Install Medicare Remit Easy Print (page 19).
- To determine the location of the HIPAA 835 folder or where your HIPAA 835 files are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC.

How to Start Medicare Remit Easy Print

1. To start Medicare Remit Easy Print, double-click the Medicare Remit Easy Print shortcut.6 The first time that you start Medicare Remit Easy Print, or when you don’t have any Remittance files in the Import folder you see the “No Remittance Files Found” dialog. Click or select OK to close the dialog.

2. Click OK.

6 Hint:
You can find the Medicare Remit Easy Print shortcut on your desktop and on the Start menu.
Medicare Remit Easy Print opens with Import ready:

3. Click Import.
A file dialog window opens permitting you to select the HIPAA 835 file to import.

4. Select the HIPAA 835 file that you want to import by double-clicking it. Medicare Remit Easy Print starts the import to let you know that it is importing:
After the import finishes, the Remittance Advice List window appears.
Locating MREP and MREP File Locations on Your PC/Network

Locating the MREP Application on Your PC/Network – Icon Available

1. With your mouse, right click the icon on your desktop.
2. Go to Properties, Shortcut, Start in and you see the directory where the Medicare Remit Easy Print directory is located.
Locating the MREP Application on Your PC/Network – Icon not Available

1. Click the Start menu.
2. Select the ‘Search’ function.
3. Select ‘For Files or Folders’.
4. Select ‘All files and folders’.
5. Type ‘Medicare Remit Easy Print’ or the name you saved your MREP software under in ‘All files and folders’.

6. Select ‘My Computer’ from the ‘Look In’ drop-down box.

7. Click Search.
Identifying Easy Print File Locations

This tool contains the current path to folders containing the files that Medicare Remit Easy Print uses. In most cases, these paths never need updating. But, in certain situations, the user may want to override the default locations of these folders.

1. To identify the necessary files/resources that Medicare Remit Easy Print is using, select Path Name Editor from the Tools menu.

![Image of Path Name Editor window]

Segment count: 32056
12/29/2011
2. The folder locations window appears showing the current folder location settings.

The **Imported files**: folder contains those files once the native 835 files have been imported into Medicare Remit Easy Print.

The **Archive files**: folder contains those files that have been archived from Medicare Remit Easy Print.

The **Exported reports**: folder contains those report files where the user chose to export the reports rather than printing them.

The **X835 native files**: folder contains the native 835 files that are imported into Medicare Remit Easy Print.

**Note**: When an issue is reported and the GDIT MREP Team requests the file sent for further investigation, this is the type of file that needs to be sent. The file has a “.txt” extension.

Identify the file/remittance advice in question or causing an issue.

For the provider/supplier community, send a copy of this file to your contractor and your contractor should send the same file to the GDIT MREP Team.

The **Resource files**: folder contains the necessary internal files (004010X091A1.FLD or 005010x221A1.FLD and loop.str) for Medicare Remit Easy Print to run. The Codes.ini file is also in this folder, but it is not required for Medicare Remit Easy Print to run. **(Note:** The Codes.ini file contains the descriptions of the CARCs, RARCs, Group Codes, and Business Scenarios. If it is not present, you receive a generic default message.)
Locating MREP and MREP File Locations on Your PC/Network

Buttons

- **Save**
  - Save changes made to the folders

- **Default**
  - Reset the values for the files back to what they were when the Medicare Remit Easy Print application was initially installed

- **Cancel**
  - Exit the Medicare Remit Easy Print Folder Locations display box without saving changes
Uninstalling Medicare Remit EasyPrint

- Navigate to the Windows Control Panel Add/Remove Programs.
  - From the taskbar, click Start > Control Panel.
  - The Control Panel window opens.

Windows 7 Control Panel
• Remove the Medicare Remit Easy Print Application.
  • Click Programs.
  • Click Programs and Features.
  • Select Medicare Remit Easy Print from the resulting list.

![Uninstall screen](image)

• Click Remove, and then click Yes on the confirmation dialog.

![Confirmation dialog](image)

The Uninstall process is complete!
Online Help System

The Medicare Remit Easy Print (MREP) Help online system allows you to look up information about MREP from MREP itself instead of referring to the Medicare Remit Easy Print User Guide. The online Help system is geared to the day-to-day tasks in MREP. It does not include information regarding the technical aspects of installing or running MREP on a PC or network.

How to Access the Online Help System

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click Help.
Medicare Remit Easy Print opens the Medicare Remit Easy Print Help window and displays the introduction.

**Note:** Be sure that the Medicare Easy Print Help dialog box appears in the Contents tab in the left frame of the window.
How to Use the Contents Tab

1. To see what's inside a book, click the + sign.
2. Click a topic to display the topic.

At this point, you can:

- Print the topic
- View Options
- Return to the previous view
- Hide the tab
How to Use the Index Tab

1. Click the Index tab.

2. Type a keyword to find.
3. Select a keyword by double clicking it or click the display.

How to Use the Search Tab

1. Click the Search tab.
2. Type a keyword to find, then click List Topics or type Alt + L.

3. Once the list of topics appears, double click the one you want.

How to Close the Medicare Remit Easy Print Help Window
Click Close Window or type Alt + F4.
Importing HIPAA 835 files

The first time that you start Medicare Remit Easy Print, you must import an HIPAA 835 file. For the procedure for the first import, see Step 1 of How to Start Medicare Remit Easy Print.

The first time you start Medicare Remit Easy Print, or when you don’t have any Remittance files in the Import folder you see the “No Remittance Files Found” dialog. Click or select OK to close the dialog.

Before You Import the HIPAA 835 File

Before you import an HIPAA 835 file, you must:

• Install the Medicare Remit Easy Print program. (See PC Installations or Network Installations)
• To determine the location of the HIPAA 835 folder or where your HIPAA 835 files are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC.

Import File Name Format

When you import the HIPAA 835 file, Medicare Remit Easy Print makes a copy of it, renames it, and stores it in the Import file folder.

The file-naming format is as follows:

PPPPPPPPPPPPPPPPPPPPPPPPPPP Payer Name – 30 bytes maximum
CCCCCCCCCCCCC Check/EFT # – 15 bytes maximum

If a file has been imported successfully and you attempt to import the same file, an error record is written to the Import Exception Summary Window/Report and the file is not imported into the MREP application. Importing a file format other than HIPAA 835v5010A1 or 835v4010A1, or a non-compliant version of a HIPAA 835-formatted file also writes a record to the Import Exception Summary window/report and the file is not imported into the MREP application.

Note: With the release of MREP v2.9 (April 2011), the only acceptable versions of the HIPAA 835 file that can be imported into MREP are 835v5010A1 and 835v4010A1.
How to Import the HIPAA 835 File


2. Click Import or go to the File menu option and select Import.

7 Hint: For information about the very first time you import, see Step 1 on page 25.
Medicare Remit Easy Print opens a window for you to select the HIPAA 835 file to import:

3. Select the HIPAA 835 file that you want to import by double-clicking it

Medicare Remit Easy Print starts the import and lets you know that it is importing:

After the import finishes, the MREP Remittance Advice List window appears.

At this point, you can:

Work with the MREP Remittance Advices See Working with MREP Remittance Advices
Work with Reports See Working with Reports

Note: Medicare Remit Easy Print reformats and saves a copy of the HIPAA 835 file. This copy is the Import file. If you import the same HIPAA 835 file more than once, Medicare Remit Easy Print bypasses the duplicate file and displays the Import Exception Summary Report indicating duplicate remittances were detected.

For information about making sense of the Import file name, see Import File Name Format.
How to Automatically Import the HIPAA 835 File


![EasyPrint.exe Properties](image)

**Note:** The values in the various fields vary for each MREP user.

- The Target: value needs to be modified to indicate the location of the files that are to be imported. The user must enter a space after the last double quote, the value of –I or –i (not case sensitive), followed by another space and the pathname. The pathname must be in double quotes. For example, "I:\Easy Print\EasyPrint.exe" –i "C:\MREP\Files to be imported\no_phi.txt"
• To save the changes you made to the Target: value, you must click Apply.

• Once you click Apply, then you must click OK. The Properties window disappears.
- You can restart the MREP software.

**Notes:**

- If the user updates the Target field with a file path that does not exist, a message dialog appears stating the target file does not exist. Once the user chooses to close this window by clicking OK, the MREP software continues to run with the files that have already been imported.

![EasyPrint Auto import function has been aborted. File C:\MREP\Files\no_phi.txt does not exist.](image)

- Each time that the MREP software is invoked, it always accesses the import pathname to attempt to import the data that is contained in the specified file.

- When a duplicate remit file or a file with an invalid data format (not 835v4010A1 or 835v5010) is encountered, the Import Exception Summary window appears. The user can choose to Print or Close this window. Once the user chooses to close this window, the MREP software continues to run with files that have already been imported.
What to Do with an Import Error Message

There are two error messages that you may see:

<table>
<thead>
<tr>
<th>For this error message</th>
<th>You need to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid File Format</td>
<td>Select the correct HIPAA 835 file to import.</td>
</tr>
<tr>
<td></td>
<td>You have either selected an ERA not in a HIPAA 835 format or an ERA that is a HIPAA 835 with invalid delimiters. If you continue to receive this error, contact your contractor.</td>
</tr>
<tr>
<td>Path / File Access Error</td>
<td>Check with your network/PC administrator</td>
</tr>
<tr>
<td></td>
<td>You need to have read/write access rights to the Medicare Remit Easy Print directory.</td>
</tr>
</tbody>
</table>
Import Exception Summary Window/Report

The Import Exception Summary window/report helps to identify duplicate files, file formats other than HIPAA 835v5010 or HIPAA 835v4010A, non-compliant HIPAA 835-formatted files, and prevents the posting of “junk” files to the import folder. If any of the scenarios that are described above are encountered while attempting to import files to the MREP application, an Import Exception Summary dialog displays a list of invalid files by Payee and Check/EFT #, in addition to a brief description of the issue encountered.
You have the option of closing the window or printing the Import Exception Summary. If you choose to print the Import Exception Summary report, the window does not close automatically once the report prints. You need to close the window using Close or “X-ing” out (top right corner of the Import Exception Summary window). The printing functionality for the Import Exception Summary report follows the existing printing functionality within MREP. Please note that if the window is closed prior to printing the report, the list of import error(s) is lost. To eliminate the need for file space management, a decision was made to not save the MREP Import Exception errors. To recreate the Import Exception Summary window, the files need to be imported again.

The Import Exception Summary window and report contains three columns of information.

- The first column of information is entitled “Payee”. Depending on what type of error is encountered during the import process, this field could contain data or spaces. The maximum number of bytes of data that can appear is 40.
- The second column of information is entitled “Check/EFT #”. Depending on what type of error is encountered during the import process, this field could contain data or spaces. The maximum number of bytes of data that can appear is 15.
- The third column of information is entitled “Reason”. Depending on what type of error that is encountered during the import process, there is the possibility of three different messages appearing.

Prior to the three columns of data, the Import Exception Summary window and report contains a heading with the title “File:” The information following the “File:” heading is the location and name of the file that the attempt is being made to import into the MREP application.

When the Import Exception Summary report prints, the printed version contains an additional heading prior the “File:” heading. It is the first heading on the report. On the left side of the page, the heading displays “Import Exception Summary”. In the center of the page, the heading displays the date and time stamp when the summary report was printed. The format of the date is MM/DD/CCYY. Please note that the leading zero in the month and day do not appear – for example: 2/15/2018. The format of the time is HH:MM:SS XX (XX represents AM or PM). On the right side of the page, the heading displays the version of the MREP application that is being used (for example: Easy Print v4.6).
Working with MREP Remittance Advices

How to View a List of Claims for an MREP Remittance Advice

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Select the Remittance Advice by clicking it.

   Medicare Remit Easy Print highlights the Remittance Advice and lists the associated claims as shown in the following image.
**Note:** Some screen reading applications may not be able to read all of the values on the claim list tab. Function key F1 displays an accessibility informational message allowing the screen reading application to recite the field names and values displayed in the listview for the highlighted claim. Please note the Patient’s Name appears the Last Name first, followed by a comma and then the First Name:

At this point, you can:

- **Find out more about this tab**
  See page *Making Sense of the Claim List Tab*

- **Print the list**
  Click \[ Print \] or go to the Tab menu option and select Print Claim List, or type Alt + B + P.
  For more info, see *How to Print a List of Claims*.

- **View claim details**
  Click \[ Claim Detail \] or go to the View menu option and select Claim Detail
  For more info, see *How to View the Detail for a Claim*.

- **View a Summary for the Remittance Advice**
  Click \[ Remit Summary \] or go to the View menu option and select Remit Summary
  For more info, see *How to View the Total Amounts for a Remittance Advice*.

- **View the data that feeds the Remittance Advice**
  Click \[ Data View \] or go to the View menu option and select Data View
  For more info, see *Making Sense of the Data View Tab*.

- **Search**
  Click \[ Search \] or go to the View menu option and select Search
  For more info, see *How to Search Payment Information*.

- **View the CARCs, RARCs, Group Codes, and Business Scenarios for the Remittance Advice**
  Click \[ Glossary \] or go to the View menu option and select Glossary
  For more info, see *Making Sense of the Glossary Tab*.
### How to View the Detail for a Claim

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Select the Remittance Advice by clicking it.

   Medicare Remit Easy Print highlights the Remittance Advice and lists the claims.

<table>
<thead>
<tr>
<th>Claim</th>
<th>ACN</th>
<th>Category</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doc, Sally</td>
<td>7722337</td>
<td>1711070001000</td>
<td>Itemized</td>
<td>510.50</td>
</tr>
<tr>
<td>Doc, Sally</td>
<td>7722337</td>
<td>1711070001000</td>
<td>Itemized</td>
<td>510.50</td>
</tr>
<tr>
<td>Miller, Mary</td>
<td>5432109</td>
<td>1721170001000</td>
<td>Itemized</td>
<td>72.20</td>
</tr>
<tr>
<td>Jones, Joe</td>
<td>9123456</td>
<td>1723070001000</td>
<td>Itemized</td>
<td>148.80</td>
</tr>
<tr>
<td>Smith, Robert</td>
<td>2151983</td>
<td>1723070002000</td>
<td>Itemized</td>
<td>40.00</td>
</tr>
</tbody>
</table>
3. Check the checkbox next to the claim(s) that you want to see detail. Detailed information only appears for claims that are checked.

4. Click the Claim Detail tab.

8 Hint: You can use the Check All and Uncheck All buttons to help you select the claims.
The detail appears for the claim you selected:

Find out more about this tab

Print the detail

Return to the Claim List

View a Summary for the Remittance Advice

See page Making Sense of the Claim Detail.

Click Print, or go to the Tab menu option and select Print Claim Detail, or type Alt + B + P.

For more info, see How to Print the Detail for a Claim.

Click the claim list tab or go to the View menu option and select Claim List.

For more info, see How to View a List of Claims for an MREP Remittance Advice.

Click the summary tab or go to the View menu option and select Remit Summary.

For more info, see How to View the Total Amounts for a Remittance Advice.
Medicare Remit Easy Print

Working with MREP Remittance Advices

View the data that feeds the Remittance Advice

Click the Data View tab or go to the View menu option and select Data View.
For more info, see *Making Sense of the Data View Tab*.

Search

Click the Search Tab or go to the View menu option and Search.
For more info, see *How to Search Payment Information*.

View the CARCs, RARCs, Group Codes, and Business Scenarios for the Remittance Advice

Click the Glossary Tab or go to the View menu option and select Glossary.
For more info, see *Making Sense of the Glossary Tab*.

Option to print or suppress the printing of the glossary of CARCs and RARCs for the Remittance Advice (not available for Remittance Advices printed from the menu bar or toolbar)

A check box with the word Glossary appears in the lower right side of the Claim Detail tab. When this check box is checked, the glossary of CARCs and RARCs involved with a particular MREP Remittance Advice prints on a separate page. When the check box is not checked, the glossary of CARCs and RARCs involved with a particular MREP Remittance Advice does not print.

You also have the option via the Tab menu option to show or not show the glossary of CARCs and RARCs involved with the MREP Remittance Advice.
How to View the Total Amounts for a Remittance Advice


2. Select the Remittance Advice by clicking it. Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

3. Click the Remit Summary Tab or type Alt + V + S. Medicare Remit Easy Print displays the totals, for example
At this point, you can:

Find out more about this tab

See Making Sense of the Remit Summary Tab.

Print the summary

Click Print or go to the Tab menu option and select Print Claim Detail or type Alt + B + P.

View claim details

Click the Claim Detail Tab or go to the View menu option and select Claim Detail

For more info, see How to View the Detail for a Claim.

Return to the Claim List

Click the Claim List tab or go to the View menu option and select Claim List

For more info, see How to View a List of Claims for an MREP Remittance Advice.

View the data that feeds the Remittance Advice

Click the Data View tab or go to the View menu option and select Data View

For more info, see Making Sense of the Data View Tab.

Search

Click the Search tab or go to the View menu option and select Search

For more info, see How to Search Payment Information.

View the CARCs, RARCs, Group Codes, and Business Scenarios for the Remittance Advice

Click the Glossary tab or go to the View menu option and select Glossary

For more info, see Making Sense of the Glossary Tab.
How to View the Data in the Import File

2. Select the Remittance Advice by clicking it. Medicare Remit Easy Print highlights the Remittance Advice and lists the claims.
3. Click the Data View Tab or type Alt + VV. Medicare Remit Easy Print displays the file format:
At this point, you can:

**Find out more about this window**

See page *Making Sense of the Data View Tab*.

**View claim details**

Click the Claim Detail tab or, go to the View menu option and select Claim Detail.

For more info, see *How to View the Detail for a Claim*.

**Return to the Claim List**

Click the Claim List tab or, go to the View menu option and select Claim List.

For more info, see *How to View a List of Claims for an MREP Remittance Advice*.

**View a Summary for the Remittance Advice**

Click the Summary tab or, go to the View menu option and select Remit Summary.

For more info, see *How to View the Total Amounts for a Remittance Advice*.

**Search**

Select the Search tab or, go to the View menu option and select Search.

For more info, see *How to Search Payment Information*.

**View the CARCs and RARCs for the Remittance Advice**

Select the Glossary tab or, go to the View menu option and select Glossary.

For more info, see *Making Sense of the Glossary Tab*.
How to View the CARC and RARC Codes

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.
   The Medicare Remit Easy Print Claim List tab opens.

2. Select the Remittance Advice by clicking it.
   Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

3. Click the Glossary Tab or type Alt + V + G.
   Medicare Remit Easy Print shows the Reason and Remark codes for the Remittance Advice:
At this point, you can:

Find out more about this tab
See page Making Sense of the Glossary Tab

View claim details
Click the Claim Detail tab or go to the View menu option and select Claim Detail.
For more info, see How to View the Detail for a Claim.

Return to the Claim List
Click the Claim List tab or go to the View menu option and select Claim List.
For more info, see How to View a List of Claims for an MREP Remittance Advice.

View a Summary for the Remittance Advice
Click the Summary tab or go to the View menu option and select Remit Summary.
For more info, see How to View the Total Amounts for a Remittance Advice on page 91.

View the data that feeds the Remittance Advice
Select the Data View tab or go to the View menu option and select Data View.
For more info, see Making Sense of the Data View Tab.

Search
Select the Search tab or go to the View menu option and select Search.
For more info, see How to Search Payment Information.

View the CARCs and RARCs for the Remittance Advice
Click Codes at the bottom of the tab or type Alt + B + C.
For more information, see How to View the CARC and RARC Codes
How to Look up a CARC/RARC Code, Group Code, or CORE Business Scenario

1. Open Medicare Remit Easy Print by double-clicking .
   The Medicare Remit Easy Print Claim List tab opens.

   The Code Descriptions window opens.
How to Update (Import) the CARC/RARC Codes, Group Codes, and CORE Business Scenarios

At a minimum, the ANSI Claim Adjustment Reason Code (CARC) and Remittance Advice Remark Code (RARC) file requires an update three times a year. When the list of codes is updated per Washington Publishing Company, GDIT provides an updated file on the VMS ETS website for the contractors and CMS provides a link to the updated file on the CMS website for the provider/supplier community. When the user finds it necessary to import this updated file into MREP, follow these instructions:

1. Access the list of the latest codes from the VMS ETS or CMS website.
2. Save the list of latest codes so they are easily accessible.
   **Note:** The file name *must* be saved as Codes.ini for MREP to successfully find the code file.
3. Select Import Code Descriptions from the Tools menu.
A dialog window appears asking to confirm the code import.

If you select NO, the dialog box disappears and no updates are made to MREP. If you select YES, another file dialog box appears.

4. Navigate to the folder or area where you saved the file under step 2. Select the Codes.ini file and then click Open.
5. After you press Open, a dialog displays confirming the code import was successful. Click, or select OK to close the dialog.

![Import New Code Information dialog]

Click OK.

6. The latest list of CARC/RARCs exists in the MREP application. To verify that the latest version exists, select Code Descriptions from the Tools menu.
7. The Easy Print – Reason/Remark/Group Codes dialog box appears.

   **Note:** The Easy Print – Reason/Remark/Group Codes dialog box includes the date of the latest version of the code list.
How to Print a List of Claims

1. View the list of claims.
   For the steps to follow, see How to View a List of Claims for an MREP Remittance Advice.

2. Click Print at the bottom of the tab or type Alt + B + P.
   The Print remit listing window opens.

3. Print the detail listing in one of the following ways:
   A. From the Print remit listing window, click Print to print the detail without previewing it.

   The Print dialog opens.
   If you need to change the properties, click Properties and make changes as necessary. Click OK. Medicare Remit Easy Print prints the detail at your default printer.

   B. From the Print remit listing window, click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

Click the Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

At this point, you can:

- **View claim details**: Click the Claim Detail tab or go to the View menu option and select Claim Detail. For more info, see *How to View the Detail for a Claim*.

- **Search**: Click the Search tab or go to the View menu option and select Search. For more info, see *How to Search Payment Information*.

- **View a Summary for the Remittance Advice**: Click the Summary tab or go to the View menu option and select Remit Summary. For more info, see *How to View the Total Amounts for a Remittance Advice*.

- **View the data that feeds the Remittance Advice**: Click the Data View tab or go to the View menu option and select Data View. For more info, see *Making Sense of the Data View Tab*.

- **View the CARCs, RARCs, Group Codes, and Business Scenarios for the Remittance Advice**: Click the Glossary tab or go to the View menu option and select Glossary. For more info, see *How to View the CARC and RARC Codes*.
How to Print the Detail for a Claim

1. View the detail for the claim.
   For the steps to follow, see How to View the Detail for a Claim.

2. Click print at the bottom of the tab, or type Alt + B + P. The Print remit listing window opens.

3. Print the detail listing in one of the following ways:
   A. Click Print to print the detail without previewing it.
      The Print dialog box opens.

      ![Print dialog box]

      If you need to change the properties, click Properties and make changes as necessary.
      Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Print the Remittance Advice Summary

1. View the Remittance Advice Summary.
   For the steps to follow, see How to View the Total Amounts for a Remittance Advice.

2. Click Print at the bottom of the tab, or type Alt + B + P.
   The Print remit listing window opens.

3. Print the detail listing in one of the following ways:
   A. Click Print to print the detail without previewing it.

   The Print dialog box opens.

   If you need to change the properties, click Properties and make changes as necessary.
   Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.

![Print Preview Window]

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
Searching Payment Information

You can search by:

- Adjusted Lines
- Bene Account Number
- Bene Last Name
- CARC
- COB Claims
- Coinsurance Lines
- Deductible Lines
- Deductible/Coins Lines
- Denied Lines
- ICN
- MID
- MSP Claims
- NDC
- Non-COB Claims
- Non-MSP Claims
- Other Adjustments
- Procedure Code
- Rendering Provider Number
- Service Date (range of dates in the format DD, DD/YY, MM, MM/DD, MM/DD/YY, MM/YY, or YY; forward slashes are not required when entering a value in the Value to Find field)
How to Search Payment Information

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.
2. Click Search or use the Search tab.

The Search tab opens.
3. Use the drop-down list to select a search field. 9

   If applicable, enter the value to find. The Search tab includes three options for how to search the field (Exact Match, Begins With, or Contains).

   To display the “searched” data, you must select one of the options before clicking Search. The Exact Match Begins With, and Contains options are only available for the MID, ICN, Bene Account Number, Bene Last Name, NDC, Procedure Code, and Rendering Provider fields.

   If the Search: field is not one of these fields, the Exact Match, Begins With, and Contains options are not available.

   If you select one of the Service Date formats from the drop-down menu, you can:

   • Enter the date in the Value to find field 10
   • Use the drop-down list only to access the Calendar picker for the MM/DD/YY format only. Use the left and right arrows to select the month, and then click the date you want.

   9 **Hint:**
   You cannot use a wild card character in the search.

   10 **Hint:**
   You can use a calendar date picker to select a service date.
5. Click the Search type to start the search.

Medicare Remit Easy Print returns all of the claim lines/info that match the search.

For example, imagine you needed to view all of Sally Doe’s claims. If the remit contains any claim lines with the name Doe, the Search Tab list view is updated with those claim lines matching the criteria.
Making Sense of the Claim List Tab

For the procedure to view the claim list, see How to View a List of Claims for an MREP Remittance Advice.

The claim list tab displays a summary of all of the claims found within the selected remittance.¹¹

<table>
<thead>
<tr>
<th>Name</th>
<th>This is the name of the beneficiary that the claim was processed for. The name field is defined as Last Name followed by the First Name. A comma separates the two names.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACNT</td>
<td>This is any internal number assigned to the claim by the provider.</td>
</tr>
<tr>
<td>ICN</td>
<td>This is the Internal Control Number (ICN), the unique number assigned to the claim when it is received by the contractor.</td>
</tr>
</tbody>
</table>

¹¹ Hint:
F1 displays a dialog box containing the listview field names and values. This enables screen reading programs to read all the listview fields for a highlighted claim.
<table>
<thead>
<tr>
<th>Billed Amount</th>
<th>This is the total claim dollar billed amount.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paid Amount</td>
<td>This is the total claim provider billed amount.</td>
</tr>
</tbody>
</table>
From Date

This is the earliest From Date of service on the claim.

To Date

This is the latest To Date of service on the claim.

ASG

This indicates whether or not the provider has accepted assignment for the claim.

Buttons

Print

Print the list; or type Alt + B + P

Check All

Select all of the claims; or type Alt + B + C

UnCheck All

Unselect all of the claims; or type Alt + B + U

View the data that feeds the remittance advice; or type Alt + V + V

Display Claim(s)

Select claims in the claim list by clicking the checkbox for the corresponding claim. To display the selected claims, select Display Claim from the Tab dropdown list.
EasyPrint displays the claim(s) information in a vertical line-by-line format.

This format provides the claim data at a glance and allows screen reading software to interpret the data more easily.
Making Sense of the Claim Detail Tab

For the procedure to view claim detail, see *How to View the Detail for a Claim.*

The Claim Detail tab displays all the claim information for each claim(s) that has been checked on the Claim List tab.

![Image of Claim Detail Tab]

**INFORMATION FOR THE CLAIM:**

**Note:** This is an image of the lower part of the window.

**First Line of Claim Line**

**NAME**

This is the name of the beneficiary for whom the claim was processed.

**MID**

This is the Medicare Identification (MID) number of the beneficiary for whom the claim was processed. This could be a Health Insurance Claim (HIC) number or Medicare Beneficiary Identification (MBI) number.

**ACNT**

This is any internal number assigned to the claim by the provider.
### Internal Control Number (ICN)
- The unique number assigned to the claim when it is received by the contractor.

### Shows whether or not the provider has accepted assignment for the claim.

### Remark codes at the claim level.

### Performing provider’s ID number.

### Date(s) of service.

### Two-digit Place of Service (POS) code

### HCPCS procedure code
- A list of these codes is available here: [https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf](https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf)

### Modifiers billed with the procedure.

### Number of services rendered.

### Amount the provider billed for the service.

### Allowed amount for the service.

### Amount of any deductible applied to the claim.
- This is the amount that the beneficiary (or other insurer, if applicable) is responsible for paying the provider.

### Amount that the beneficiary (or other insurer, if applicable) is responsible for paying the provider.

### Amount the provider was paid for the service.

### Remittance Advice Remark Codes at the line level.

### Submitted number of services.

### HCPCS procedure code

### Group Codes and Claim Adjustment Reason Codes for the service line

### Amount of any adjustment made based on the Group and Claims Adjustment Reason Code

### Quantity of units of service being adjusted

### CORE-defined Business Scenarios associated with the Claim Adjustment Reason Code

### Line item control number.

### Healthcare Policy Identification number

### Total amount that the beneficiary owes the provider for this claim

### Total amount of all claim adjustments on all service lines

### Totals for all service-line level amounts:
- **BILLED**
- **ALLOWED**
- **DEDUCT**
- **COINS**
- **PROV-PD**
- **ADJ TO TOTALS:**

### Blank in Medicare Remit Easy Print

### Interest amount paid for claims processing time

### Late filing charge

---

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS) under contract HHSN-316-2012-00023W / HHSM-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
### Medicare Remit Easy Print

**Working with MREP Remittance Advices**

<table>
<thead>
<tr>
<th><strong>NET</strong></th>
<th>Amount that Medicare owes the provider for this claim</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CLAIM INFORMATION</strong></td>
<td>Appears when the claim is forwarded to a beneficiary’s supplemental insurer</td>
</tr>
<tr>
<td><strong>FORWARDED TO:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>CORRECTED PRIORITY</strong></td>
<td>Corrected priority payer name and/or id number</td>
</tr>
<tr>
<td><strong>PAYER INFO:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>OTHER CLAIM REL IDENTIFICATION:</strong></td>
<td>Additional information relevant to the adjudication of the claim and a qualifier identifying the type of reference information</td>
</tr>
<tr>
<td><strong>GLOSSARY</strong></td>
<td>Reason, Remark, Group codes, and Business Scenarios that are also shown on the Glossary tab</td>
</tr>
</tbody>
</table>

**Buttons**

- **Print**: Print the claim detail; or press Alt + B + P
- **Zoom In**: Make the size of the type larger; or press Alt + B + I
- **Zoom Out**: Make the size of the type smaller; or press Alt + B + O
- **Reset Zoom**: Reset the type to the original size; or press Alt + B + R
- **Glossary**: Check to see CARCs/RARCs and Business Scenarios with descriptions for the selected claims; or press Alt + B + S
Making Sense of the Remit Summary Tab

For the procedure to view the Remittance Advice detail, see How to View the Total Amounts for a Remittance Advice.

The Remit Summary Tab displays total dollar amounts, claim counts, and provider adjustment information if present in the selected remittance.
PLB ADJ DETAILS

Remittance-level (PLB) adjustment
This field only appears if a remittance-level adjustment is present.

Buttons

- Print
  - Print the summary; or type Alt + B + P

- Zoom In
  - Make the size of the type larger; or type Alt + B + I

- Zoom Out
  - Make the size of the type smaller; or type Alt + B + O

- Reset Zoom
  - Reset the type to its original size; or type Alt + B + R
Making Sense of the Data View Tab

For the procedure to view the data, see How to View the Data in the Import File.

The Data View Tab displays the remittance fields as they are stored internally in MREP. The data are stored in what are referred to as Segments. Each segment contains a varying number of elements or fields.


© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-0023W / HHSM-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
Making Sense of the Search Tab

For the procedure to view the data, see *How to Search Payment Information*.

The Search tab displays a summarized list of claim information that matches the criteria of the user’s search. The Name field’s format is the beneficiary’s Last Name, followed by a comma and then the First Name.

Buttons

- **Print Results**
  - Print the list of claims from the search; or type Alt + B + P

- **Claim Detail**
  - View details for all of the claims from the search; or type Alt + B + C
Making Sense of the Glossary Tab

For the procedure to view the data shown in the Glossary Tab see How to View the CARC and RARC Codes.

The Glossary tab displays the CAGC/CARC/RARC code and Business Scenario with descriptions for the selected remittance.

Buttons

- **Zoom In**: Make the size of the type larger; or type Ctrl + B + I
- **Zoom Out**: Make the size of the type smaller; or type Ctrl + B + O
- **Reset Zoom**: Reset the type to its original size; type Ctrl + B + R
- **Codes**: Displays CARCs/RARCs and descriptions for the selected claims when checked; or type Ctrl + B + S

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-00023W / HHSN-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
Working with Reports

Medicare Remit Easy Print provides 11 different reports:

- Denied Service Lines
- Adjusted Service Lines
- Deductible Service Lines
- Coinsurance Service Lines
- Deductible/Coinsurance Service Lines
- COB Claims Report
- Non-COB Claims Report
- MSP Claims Report
- Non-MSP Claims Report
- Other Adjustment Report
- Entire Remittance
Making Sense of the Denied Service Lines Report

This report displays claim service lines that have an allowed amount equal to zero and are associated with a claim that does NOT have a claim status 22 (reversed claim). The report includes only the lines on the claim that meet these criteria.
Making Sense of the Adjusted Service Lines Report

This report displays claims that have a status of 22 (reversed claim).

This report does NOT show the adjustment claim that reflects the corrected dollar amounts.
Making Sense of the Deductible Service Lines Report

This report shows claim service lines that have deductible amounts greater than zero, as well as those service lines with only deductible amounts greater than zero. It includes only the lines on the claim that meet these criteria.
Making Sense of the Coinsurance Service Lines Report

This report shows claim service lines that have coinsurance amounts greater than zero, as well as those service lines with only coinsurance amounts greater than zero. It includes only the lines on the claim that meet these criteria.
Making Sense of the Deductible/Coinsurance Service Lines Report

This report shows claim service lines that have both deductible and coinsurance amounts greater than zero, as well as those service lines with only coinsurance and deductible amounts greater than zero. It includes only the lines on the claim that meet these criteria.

<table>
<thead>
<tr>
<th>Seq #</th>
<th>Payee</th>
<th>Claim # / Date</th>
<th>ICD Code</th>
<th>Service Date(s)</th>
<th>Proc/Serv ID</th>
<th>Bills</th>
<th>Allowed</th>
<th>Denial Code</th>
<th>Cause Code</th>
<th>Pay to Provider</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>15.00</td>
<td>13.10</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1002</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>220.00</td>
<td>220.00</td>
<td>8.00</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1003</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1004</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1005</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1006</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1007</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1008</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1009</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1010</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1011</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1012</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1013</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1014</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1015</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
<tr>
<td>1016</td>
<td>CMS</td>
<td>0248050103</td>
<td>712157</td>
<td>1728000100/100</td>
<td>A1</td>
<td>12.50</td>
<td>12.50</td>
<td>8.00</td>
<td>2.00</td>
<td>13.54</td>
</tr>
</tbody>
</table>

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-00023E / HHSM-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
Making Sense of the COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that were crossed over. The requirement for crossover claims to print on the report is that the 2100 loop; CLP02 data field must contain one of the following values:

19  Processed as Primary, Forwarded to Additional Payer(s)
20  Processed as Secondary, Forwarded to Additional Payer(s)
21  Processed as Tertiary, Forwarded to Additional Payer(s)

<table>
<thead>
<tr>
<th>Case#</th>
<th>SPT#</th>
<th>Name</th>
<th>NPI</th>
<th>ICN</th>
<th>Billed</th>
<th>Allowed</th>
<th>Deductible</th>
<th>OutOfNet</th>
<th>Paid</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001</td>
<td>Y2323</td>
<td>Dr. Smith</td>
<td>123456789</td>
<td>0987654321</td>
<td>100.00</td>
<td>90.00</td>
<td>0.00</td>
<td>10.00</td>
<td>90.00</td>
</tr>
<tr>
<td>00002</td>
<td>K4444</td>
<td>Dr. Jones</td>
<td>987654321</td>
<td>8765432109</td>
<td>200.00</td>
<td>180.00</td>
<td>0.00</td>
<td>20.00</td>
<td>180.00</td>
</tr>
<tr>
<td>00003</td>
<td>J3232</td>
<td>Dr. Lee</td>
<td>654321098</td>
<td>5432109876</td>
<td>150.00</td>
<td>130.00</td>
<td>0.00</td>
<td>20.00</td>
<td>130.00</td>
</tr>
</tbody>
</table>

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS)
under contract HHSN-316-2012-00023W / HHSN-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
Making Sense of the Non-COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that did not cross over. The requirement for claims to print on the report is that the 2100.CLP02 data field does not contain one of the following values:

- 19 Processed as Primary, Forwarded to Additional Payer(s)
- 20 Processed as Secondary, Forwarded to Additional Payer(s)
- 22 Processed as Tertiary, Forwarded to Additional Payer(s)

<table>
<thead>
<tr>
<th>Snge</th>
<th>ACCT#</th>
<th>Name</th>
<th>MED</th>
<th>DCN</th>
<th>Billed</th>
<th>Allowed</th>
<th>Deductible</th>
<th>QMB</th>
<th>OSBS</th>
<th>Paid</th>
</tr>
</thead>
<tbody>
<tr>
<td>11500</td>
<td>12462355</td>
<td>Miller, Mary</td>
<td>2232222222</td>
<td>37020903000000</td>
<td>30.20</td>
<td>30.20</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>30.20</td>
</tr>
<tr>
<td>11500</td>
<td>2125656</td>
<td>Jones, Joe</td>
<td>6666666666</td>
<td>37230700300000</td>
<td>100.20</td>
<td>100.20</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>100.20</td>
</tr>
<tr>
<td>11500</td>
<td>2154999</td>
<td>Smith, Robert</td>
<td>5555555555</td>
<td>37220700000000</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>40.00</td>
</tr>
</tbody>
</table>
Making Sense of the MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 835v5010 file that were processed by Medicare as secondary. The claims have a value of 2 (Processed as Secondary) or 20 (Processed as Secondary, Forwarded to Additional Payer(s)) in the 2100 loop, CLP02 data field.
Making Sense of the Non-MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 835v5010 file that were processed by Medicare as primary. The claims have a value of 1 (Processed as Primary) or 19 (Processed as Primary, Forwarded to Additional Payer(s)) in the 2100.CLP02 data field.

<table>
<thead>
<tr>
<th>Amount</th>
<th>CLM #</th>
<th>Paid</th>
<th>Carrier</th>
<th>Name</th>
<th>MPT</th>
<th>Billing Source</th>
<th>LOB</th>
<th>LOB ID</th>
<th>DME</th>
<th>Allowed</th>
<th>Deductible</th>
<th>COSTCO</th>
<th>Processed as Primary</th>
<th>Processed as Primary, Forwarded to Additional Payer(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1048.80</td>
<td>17422809</td>
<td>254.10</td>
<td>AERA INSURANCE</td>
<td>Mary</td>
<td>111111111A</td>
<td>27202200200000</td>
<td>910.60</td>
<td>594.20</td>
<td>0.00</td>
<td>249.82</td>
<td>577.28</td>
<td>Payers</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>209.30</td>
<td>17422809</td>
<td>109.20</td>
<td>AERA INSURANCE</td>
<td>Sam</td>
<td>333333333A</td>
<td>27202200200000</td>
<td>237.40</td>
<td>190.20</td>
<td>0.00</td>
<td>39.00</td>
<td>150.30</td>
<td>Payers</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>150.30</td>
<td>17422809</td>
<td>85.50</td>
<td>AERA INSURANCE</td>
<td>John</td>
<td>444444444A</td>
<td>27202200200000</td>
<td>165.00</td>
<td>110.92</td>
<td>0.00</td>
<td>29.10</td>
<td>50.42</td>
<td>Payers</td>
<td>YES</td>
<td>NO</td>
</tr>
<tr>
<td>1094.50</td>
<td>17422809</td>
<td>1040.82</td>
<td>AERA INSURANCE</td>
<td>Jane</td>
<td>555555555A</td>
<td>27202200200000</td>
<td>1284.50</td>
<td>1040.82</td>
<td>0.00</td>
<td>207.78</td>
<td>839.06</td>
<td>Payers</td>
<td>YES</td>
<td>NO</td>
</tr>
</tbody>
</table>
Making Sense of the Other Adjustments Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that had some type of adjustment. Claims that have Late Filing and Interest and remittances that have Withholding and a Forwarding Balance appear on the report.
Making Sense of the Entire Remittance Report

This report contains the entire remittance report for the provider or supplier. You see the same information that was sent to the provider or supplier.

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS) under contract HHSN-316-2012-00023W / HHSM-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.

104
How to Print the Denied Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.

A. Click the down arrow on Report.

The Report List appears.
3. Select Denied Service Lines.
4. The Print and Export options appear:

5. Select Print.

The Print denied line report window opens.

6. Print the detail listing in one of the following ways:

A. From the Print denied line report window, click Print to print the detail without previewing it.
The Print dialog opens, for example:

If you need to change the properties, click Properties and make changes as necessary. Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. From the Print denied line report window, click Preview to see a preview of the printed page before printing.

The Print Preview window opens

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Denied Service Lines Report

You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.

The Report List appears.
3. Select Denied Service Lines.

The Print and Export options appear.
4. Select Export.
The Export folder window opens.¹²

5. Enter the file name.
6. Click Save.

¹² **Hint:**
When you export, the default folder is the ReportExport folder in the Medicare Remit Easy Print directory.
You can select another location using the Save in drop-down list menu.

© 2018 Sponsored by the Centers for Medicare & Medicaid Services (CMS) under contract HHSN-316-2012-00023W / HHSM-500-2016-00005U – DME Shared System Maintenance. This document contains confidential and proprietary information, which shall not be used, disclosed, or reproduced without the express written consent of CMS.
How to Print the Adjusted Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

3. Select Adjusted Service Lines.
The Print and Export options appear.

4. Select Print. The Print remit listing window appears.

5. From the Print remit listing window, print the detail listing in one of the following ways:
   C. Click Print to print the detail without previewing it.
The Print dialog opens, for example:

If you need to change the properties, click Properties and make changes as necessary. Click OK. Medicare Remit Easy Print prints the detail at your default printer.

D. Click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Adjusted Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

3. Select Adjusted Service Lines.
The Print and Export options appear.

4. Select Export.
The Export folder window opens.¹²

5. Enter the file name.
6. Click Save.
How to Print the Deductible Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

<table>
<thead>
<tr>
<th>Claim ID</th>
<th>Name</th>
<th>Service Code</th>
<th>Billed Amount</th>
<th>Paid Amount</th>
<th>From Date</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456</td>
<td>Doe, Sally</td>
<td>12345678</td>
<td>910.50</td>
<td>587.25</td>
<td>2/10/2004</td>
<td>2/10/2004</td>
</tr>
<tr>
<td>111111</td>
<td>Smith, John</td>
<td>12345678</td>
<td>237.00</td>
<td>194.35</td>
<td>3/10/2004</td>
<td>3/10/2004</td>
</tr>
<tr>
<td>111111</td>
<td>Doe, Sally</td>
<td>12345678</td>
<td>400.20</td>
<td>32.67</td>
<td>2/10/2004</td>
<td>2/10/2004</td>
</tr>
<tr>
<td>111111</td>
<td>Doe, Sally</td>
<td>12345678</td>
<td>140.60</td>
<td>92.42</td>
<td>3/10/2004</td>
<td>3/10/2004</td>
</tr>
<tr>
<td>111111</td>
<td>Smith, John</td>
<td>12345678</td>
<td>40.00</td>
<td>0.00</td>
<td>12/20/2003</td>
<td>12/22/2003</td>
</tr>
</tbody>
</table>

3. Select Deductible/COINS Service Lines.
The Deductive/COINS Service Lines report options appear.

4. Select Deductible Lines:
5. Select Print. The Print remit listing window appears.

6. Print the detail listing in one of the following ways:

   A. Click Print to print the detail without previewing it.
The Print dialog opens.

![Print dialog](img)

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. Click Preview to view a preview of the printed page before printing.

![Print Preview window](img)

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Deductible Service Lines Report


2. Click the down arrow on Report.
The Report List appears.

3. Select Deductible/COINS Service Lines.
The Deductible/COIN Service Lines report options appear.

4. Select Deductible Lines.
5. Select Export.
6. The Export folder window opens. 

![](image)

6. Enter the file name.
7. Click Save.
How to Print theCoinsurance Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.

A. Click the down arrow on Report.
2. Select Deductible/COINS Service Lines.
The Deductible/COINS Service Lines report options appear.

3. Select Coinsurance Lines.
4. Select Print. The Print remit listing window appears.

5. Print the detail listing in one of the following ways:

   B. From the Print remit listing window, click Print to print the detail without previewing it.
The Print dialog opens.

If you need to change the properties, click Properties and make changes as necessary. Click OK. Medicare Remit Easy Print prints the detail at your default printer.

C. From the Print remit listing window, click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

D. Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Coinsurance Service Lines Report


2. Click the down arrow on Report.
The Report List appears.

3. Select Deductible/COINS Service Lines.
The Deductible/COIN report options appear.

4. Select Coinsurance Lines.
5. Select Export.
The Export folder window opens.  

6. Enter the file name.  
7. Click Save.
How to Print the Deductible/Coinsurance Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

<table>
<thead>
<tr>
<th>Class List</th>
<th>Class Detail</th>
<th>Report Summary</th>
<th>Delta Tpr</th>
<th>Search</th>
<th>Glossary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>ACM</td>
<td>TC</td>
<td>Pld Amount</td>
<td>Pld Amount</td>
<td>Trn Date</td>
</tr>
<tr>
<td>Fry, Sally</td>
<td>1234567</td>
<td>89012345</td>
<td>-910.50</td>
<td>-462.25</td>
<td>2/10/2004</td>
</tr>
<tr>
<td>Fry, Sally</td>
<td>1234567</td>
<td>89012345</td>
<td>910.50</td>
<td>567.25</td>
<td>2/10/2004</td>
</tr>
<tr>
<td>Truth, Samuel</td>
<td>1234567</td>
<td>89012345</td>
<td>38.20</td>
<td>22.50</td>
<td>1/12/2005</td>
</tr>
<tr>
<td>Fry, Sally</td>
<td>1234567</td>
<td>89012345</td>
<td>297.40</td>
<td>155.30</td>
<td>3/20/2005</td>
</tr>
<tr>
<td>Fry, Sally</td>
<td>1234567</td>
<td>89012345</td>
<td>496.20</td>
<td>32.67</td>
<td>2/10/2005</td>
</tr>
</tbody>
</table>

3. Select Deductible/COINS Service Lines.
The Deductible/COIN report options appear.

4. Select Deductible & Coinsurance Lines:
5. Select Print.

The Print remit listing window appears.

6. Print the detail listing in one of the following ways:

A. From the Print remit listing window, click Print to print the detail without previewing it.
The Print dialog box opens.

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

7. From the Print remit listing window, click Preview to view a preview of the printed page before printing.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Deductible/Coinsurance Service Lines Report


2. Click the down arrow on Report.
The Report List appears.

3. Select Deductible/COINS Service Lines.
The Deductible/COINS report options appear.

4. Select the Deductible & Coinsurance Lines:
5. Select Export.
The Export folder window opens.\textsuperscript{12}

6. Enter the file name.
7. Click Save.
How to Print the COB Claims Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
3. Select COB/Non-COB Claims.
The Print and Export options appear.

4. Select COB Claims.
5. Select Print.

The Print denied line report window opens.

6. Print the detail listing in one of the following ways:

   A. From the Print denied line report window, click Print to print the detail without previewing it.
The Print dialog box opens.

![Print dialog box](image)

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

7. From the Print denied line report window, click Preview to view a preview of the printed page before printing.

![Print denied line report](image)

The Print Preview window opens.

![Print preview](image)

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the COB Claims Report

You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.
   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

3. Select COB/Non-COB Claims.
4. Select COB Claims.

The Print and Export options appear.

5. Select Export.
6. Enter the file name.
7. Click Save.

13 **Hint:** When you export, the default folder is the ReportExport folder in the Medicare Remit Easy Print directory. You can select another location using the Save in drop-down list menu.
How to Print the Non-COB Claims Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

3. Select COB/Non-COB Claims.
4. Select Non-COB Claims.
   The Print and Export options appear.
5. Select Print.
   The Print denied line report window opens.

6. Print the detail listing in one of the following ways:
   A. From the Print denied line report window, click Print to print the detail without previewing it.
The Print dialog opens, for example:

If you need to change the properties, click Properties and make changes as necessary. Click OK. Medicare Remit Easy Print prints the detail at your default printer.

7. From the Print denied line report window, click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Non-COB Claims Report

You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

   ![Medicare Remit Easy Print](image)

2. Click the down arrow on Report.
The Report List appears.

3. Select COB/Non-COB Claims.
4. Select Non-COB Claims.
The Print and Export options appear.

5. Select Export.
The Export folder window opens.\(^\text{13}\)

6. Enter the file name.
7. Click Save.
How to Print the MSP Claims Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

4. Select MSP Claims.
The Print and Export options appear.

5. Select Print.
6. Print the detail listing in one of the following ways:

7. From the Print denied line report window, click Print to print the detail without previewing it.

The Print denied line report window opens.

8. From the Print denied line report window, click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

Click Printer at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
How to Export the MSP Claims Report

You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
4. Select MSP Claims.
The Print and Export options appear.

5. Select Export.
The Export folder window opens.13

6. Enter the file name.
7. Click Save.
How to Print the Non-MSP Claims Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
   
The Print and Export options appear.
5. Select Print.
   The Print denied line report window opens.

6. Print the detail listing in one of the following ways:

7. From the Print denied line report window, click Print to print the detail without previewing it.
The Print dialog box opens.

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

8. From the Print remit listing window, click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Non-MSP Claims Report

You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Print and Export options appear.

5. Select Export.
The Export folder window opens.\textsuperscript{13}

6. Enter the file name.
7. Click Save.
How to Print the Other Adjustments Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
3. Select Other Adjustments.
The Print and Export options appear.

4. Select Print.
   The Print denied line report window opens.

5. Print the detail listing in one of the following ways:

6. From the Print denied line report window, click Print to print the detail without previewing it.
The Print dialog opens.

![Print dialog]

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

7. From the Print denied line report window, click Preview to view a preview of the printed page before printing.

![Print denied line report]

The Print Preview window opens.

![Print preview]

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
How to Export the Other Adjustments Report

You export the report in .csv (comma separated values) format.


2. Click the down arrow on Report.
The Report List appears.

3. Select Other Adjustments.
The Print and Export options appear.

The Export folder window opens.¹³

5. Enter the file name.
6. Click Save.
How to Print the Entire Remittance Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. Click the down arrow on Report.
The Report List appears.

3. Select Entire Remittance.

The Print remittance window appears.

4. Print the detail listing in one of the following ways:

5. From the Print remittance window, click Print to print the detail without previewing it.
The Print dialog box opens.

![Print dialog box]

If you need to change the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

6. From the Print Remit listing window, click Preview to view a preview of the printed page before printing.

![Print Remit listing]

The Print Preview window opens.

![Print Preview]

Click Printer at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
Housekeeping for the Import Files

Housekeeping includes:

- Archiving files
- Restoring files
- Deleting files

Archiving Import Files

Medicare Remit Easy Print does NOT automatically archive any Import file, and Import files can slow down the processing time of the PC.

Therefore, Medicare Remit Easy Print lets you archive Import files. The location you choose for the archive must have adequate security to protect PHI.

How to Archive Import files

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.
The Medicare Remit Easy Print Claim List tab opens.

2. On the top of the window, select the file that you want to archive and click Archive.
The Archive Imported Files window opens.\(^\text{14}\)

3. Select the file(s) you want to archive by checking the box or boxes. \(^\text{15}\)
   This activates Archive.
4. Click Archive.
   Medicare Remit Easy Print moves the file to the Archive folder.

\(^\text{14}\) **Hint:**
You can use Browse to specify another location for the archived file.

\(^\text{15}\) **Hint:**
When you need to archive all the payers in the list, you can place a checkmark in the Check All box to archive all the claim files. When you check that option a checkmark is placed in front of all claims in the list.
Restoring Import files

You can restore an Import file after you have archived it.

For information about archiving Import files, see Archiving Import Files.

How to Restore Import files

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

   The Medicare Remit Easy Print Claim List tab opens.

2. On the top of the window, click Restore.
The Restore Imported Files window opens.

3. Select the file(s) you want to restore by checking the box or boxes. This activates Restore.

4. Click Restore.

Medicare Remit Easy Print moves the file from the Archive folder to the Import folder. The file is now available for viewing on your C drive at C:\Program Files\Medicare Remit EasyPrint\Import.

Deleting Import files

If you delete an Import file by mistake, you must re-import the HIPAA 835 file. You cannot restore the Import file.

How to Delete an Import file

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

The Medicare Remit Easy Print Claim List tab opens.
2. On the top of the window, click Delete.
The Delete selected import file(s) window opens.

3. Select the file(s) you want to delete by checking the box(es). This activates Delete.
4. Click Delete.

Medicare Remit Easy Print deletes the file(s).

**Hint:**
To delete all the claim files on the list, place a checkmark in the Check All box. When you check that box checkmark is placed in front of all the claims in the list.
# Using Keystroke Shortcuts

You can use a series of keystrokes to complete a number of tasks.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Use This Combination…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import a HIPAA 835 file</td>
<td>Alt + F + I</td>
</tr>
<tr>
<td>View a list of claims</td>
<td>Alt + V + L</td>
</tr>
<tr>
<td>View claim detail</td>
<td>Alt + V + D</td>
</tr>
<tr>
<td>View totals</td>
<td>Alt + V + S</td>
</tr>
<tr>
<td>View the way the data is stored in the file</td>
<td>Alt + V + V</td>
</tr>
<tr>
<td>Search the Remittance Advice</td>
<td>Alt + V + E or</td>
</tr>
<tr>
<td></td>
<td>Alt + S + S</td>
</tr>
<tr>
<td>View the CARC and RARC codes for the Remittance Advice</td>
<td>Alt + V + G</td>
</tr>
<tr>
<td>Look up the meaning of a CARC/RARC code</td>
<td>Alt + T + C</td>
</tr>
<tr>
<td>Print the Adjusted Service Lines Report</td>
<td>Alt + R + A + P</td>
</tr>
<tr>
<td>Export the Adjusted Service Lines Report</td>
<td>Alt + R + A + E</td>
</tr>
<tr>
<td>Print the COB Claims Report</td>
<td>Alt + R + B + C + P</td>
</tr>
<tr>
<td>Export the COB Claims Report</td>
<td>Alt + R + B + C + E</td>
</tr>
<tr>
<td>Print the Non-COB Claims Report</td>
<td>Alt + R + B + N + P</td>
</tr>
<tr>
<td>Export the Non-COB Claims Report</td>
<td>Alt + R + B + N + E</td>
</tr>
<tr>
<td>Print the Deductible Service Lines Report</td>
<td>Alt + R + E + D + P</td>
</tr>
<tr>
<td>Export the Deductible Service Lines Report</td>
<td>Alt + R + E + D + E</td>
</tr>
<tr>
<td>Print the Coinsurance Service Lines Report</td>
<td>Alt + R + E + C + P</td>
</tr>
<tr>
<td>Export the Coinsurance Service Lines Report</td>
<td>Alt + R + E + C + E</td>
</tr>
<tr>
<td>Print the Deductible/Coinsurance Service Lines Report</td>
<td>Alt + R + E + E + P</td>
</tr>
<tr>
<td>Export the Deductible/Coinsurance Service Lines Report</td>
<td>Alt + R + E + E + E</td>
</tr>
<tr>
<td>Print the Denied Service Lines Report</td>
<td>Alt + R + D + P</td>
</tr>
<tr>
<td>Export the Denied Service Lines Report</td>
<td>Alt + R + D + E</td>
</tr>
<tr>
<td>Print the MSP Claims Report</td>
<td>Alt + R + M + M + P</td>
</tr>
<tr>
<td>To Do This…</td>
<td>Use This Combination…</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Export the MSP Claims Report</td>
<td>Alt + R + M + M + E</td>
</tr>
<tr>
<td>Print the Non-MSP Claims Report</td>
<td>Alt + R + M + N + P</td>
</tr>
<tr>
<td>Export the Non-MSP Claims Report</td>
<td>Alt + R + M + N + E</td>
</tr>
<tr>
<td>Print the Other Adjustments Report</td>
<td>Alt + R + O + P</td>
</tr>
<tr>
<td>Export the Other Adjustments Report</td>
<td>Alt + R + O + E</td>
</tr>
<tr>
<td>Print the Entire Remittance Report</td>
<td>Alt + R + P</td>
</tr>
<tr>
<td>Archive Import files</td>
<td>Alt + T + A</td>
</tr>
<tr>
<td>Restore archived Import files</td>
<td>Alt + T + R</td>
</tr>
<tr>
<td>Delete Import files</td>
<td>Alt + T + D</td>
</tr>
</tbody>
</table>

**With the Claim List Tab Selected:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Claim List</td>
<td>Alt + B + P</td>
</tr>
<tr>
<td>Check all claims in the list</td>
<td>Alt + B + C</td>
</tr>
<tr>
<td>Uncheck all claims in the list</td>
<td>Alt + B + U</td>
</tr>
</tbody>
</table>

**With the Claim Detail Tab Selected:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Claim Detail</td>
<td>Alt + B + P</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Alt + B + I</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Alt + B + O</td>
</tr>
<tr>
<td>Reset Zoom</td>
<td>Alt + B + R</td>
</tr>
<tr>
<td>Show Glossary ( check box )</td>
<td>Alt + B + S</td>
</tr>
</tbody>
</table>

**With the Remit Summary Tab Selected:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Summary</td>
<td>Alt + B + P</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Alt + B + I</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Alt + B + O</td>
</tr>
<tr>
<td>Reset Zoom</td>
<td>Alt + B + R</td>
</tr>
</tbody>
</table>

**With the Search Tab Selected:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Results</td>
<td>Alt + B + P</td>
</tr>
<tr>
<td>Claim Detail Results</td>
<td>Alt + B + C</td>
</tr>
</tbody>
</table>

17 After executing a search
### To Do This…

<table>
<thead>
<tr>
<th>With the Glossary Tab Selected:</th>
<th>Use This Combination…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Alt + B + I</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Alt + B + O</td>
</tr>
<tr>
<td>Reset Zoom</td>
<td>Alt + B + R</td>
</tr>
<tr>
<td>Codes</td>
<td>Alt + B + C</td>
</tr>
</tbody>
</table>
Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk

This information can help you if you need to troubleshoot the Import file.

**Note:** This appendix represents the fields of an 835v5010 electronic remittance advice. However, MREP can also print or display remittances in the 4010A1 format. Fields marked with an asterisk (*) below are not found on the 4010A1 format and do not appear when printed or shown.

<table>
<thead>
<tr>
<th>Remittance Advice Field</th>
<th>835 Loop ID</th>
<th>835 Segment Field</th>
<th>Identification/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payer (Contractor) Name</td>
<td>1000A</td>
<td>N102</td>
<td>N101 = ‘PR’</td>
</tr>
<tr>
<td>Payer (Contractor) Address</td>
<td>1000A</td>
<td>N301</td>
<td>N101 = ‘PR’, ADDR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N302</td>
<td>N101 = ‘PR’, ADDR2</td>
</tr>
<tr>
<td>Payer (Contractor) City</td>
<td>1000A</td>
<td>N401</td>
<td>N101 = ‘PR’</td>
</tr>
<tr>
<td>Payer (Contractor) State</td>
<td>1000A</td>
<td>N402</td>
<td>N101 = ‘PR’</td>
</tr>
<tr>
<td>Payer (Contractor) ZIP</td>
<td>1000A</td>
<td>N403</td>
<td>N101 = ‘PR’</td>
</tr>
<tr>
<td>* PAYER’S WEB SITE:</td>
<td>1000A</td>
<td>PER04</td>
<td>PER01 = ‘IC’</td>
</tr>
<tr>
<td>* PAYER BUSINESS CONTACT INFORMATION:</td>
<td>1000A</td>
<td>PER01 = ‘CX’</td>
<td></td>
</tr>
<tr>
<td>* Name</td>
<td></td>
<td>PER02</td>
<td></td>
</tr>
<tr>
<td>* Email Address (up to 50 positions)</td>
<td>PER04 or PER06</td>
<td>PER03 or PER05 = ‘EM’ (respectively)</td>
<td></td>
</tr>
<tr>
<td>* Telephone Number</td>
<td></td>
<td>PER04 and PER06</td>
<td>PER03 = ‘TE’ and PER05 = ‘EX’</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PER06 and PER08</td>
<td>PER05 = ‘TE’ and PER07 = ‘EX’</td>
</tr>
<tr>
<td>* PAYER TECHNICAL CONTACT INFORMATION:</td>
<td>1000A</td>
<td>PER01 = ‘BL’</td>
<td></td>
</tr>
<tr>
<td>Payee (Provider) Name</td>
<td>1000B</td>
<td>N102</td>
<td>N101 = ‘PE’</td>
</tr>
<tr>
<td>Payee (Provider) Address</td>
<td>1000B</td>
<td>N301</td>
<td>N101 = ‘PE’, ADDR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N302</td>
<td>N101 = ‘PE’, ADDR2</td>
</tr>
<tr>
<td>Payee (Provider) City</td>
<td>1000B</td>
<td>N401</td>
<td>N101 = ‘PE’</td>
</tr>
<tr>
<td>Payee (Provider) State</td>
<td>1000B</td>
<td>N402</td>
<td>N101 = ‘PE’</td>
</tr>
<tr>
<td>Payee (Provider) ZIP</td>
<td>1000B</td>
<td>N403</td>
<td>N101 = ‘PE’</td>
</tr>
<tr>
<td>PROVIDER # or NPI #</td>
<td>1000B</td>
<td>N104</td>
<td>N101 = ‘PE’ &amp; N103 = ‘XX’</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or REF02</td>
<td>Payee level REF01 = ‘1C’</td>
</tr>
<tr>
<td>Date</td>
<td>BPR16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHECK/EFT #</td>
<td>TRN02</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Assigned claims</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME (Patient Last Name)</td>
<td>2100</td>
<td>NM103</td>
<td>NM101 = ‘QC’</td>
</tr>
<tr>
<td>NAME (Patient First Name)</td>
<td>2100</td>
<td>NM104</td>
<td>NM101 = ‘QC’ / NM102 = ‘1’</td>
</tr>
<tr>
<td>Remittance Advice Field</td>
<td>835 Loop ID</td>
<td>835 Segment Field</td>
<td>Identification/Comments</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>NAME (Patient Middle Name)</td>
<td>2100</td>
<td>NM105</td>
<td>NM101 = 'QC' / NM102 = '1'</td>
</tr>
<tr>
<td>MID (Patient ID)</td>
<td>2100</td>
<td>NM109</td>
<td>NM108 = 'HN' or 'C'</td>
</tr>
<tr>
<td>ACNT (Patient Account Number)</td>
<td>2100</td>
<td>CLP01</td>
<td></td>
</tr>
<tr>
<td>ICN (Claim Control Number)</td>
<td></td>
<td>CLP07</td>
<td></td>
</tr>
<tr>
<td>ASG (Claim Assignment)</td>
<td>2000</td>
<td></td>
<td>Hard-coded ‘Y’ for Medicare when LX01 = ‘1’</td>
</tr>
<tr>
<td>MOA (Claim Level Remark Codes)</td>
<td>2100</td>
<td>MOA03, MOA04, MOA05, MOA06, MOA07</td>
<td></td>
</tr>
<tr>
<td>REND PROV (Rendering Provider)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = HPI or REF01 = ‘1C’</td>
</tr>
<tr>
<td></td>
<td>2100</td>
<td>NM109 or REF02</td>
<td>NM108 = ‘XX’ or REF01 = ‘1C’</td>
</tr>
<tr>
<td></td>
<td>1000B</td>
<td>N104 or REF02 or N104 = ‘XX’ or REF01 = ‘XX’</td>
<td></td>
</tr>
<tr>
<td>SERV-DATE (From Service Date)</td>
<td>2110</td>
<td>DTM02</td>
<td>Line level DTM01 = ‘150’ or ‘472’ else Claim level DTM01 = 232</td>
</tr>
<tr>
<td>SERV-DATE (To Service Date)</td>
<td>2110</td>
<td>DTM02</td>
<td>Line level DTM01 = ‘151’ or ‘472’ else Claim level DTM01 = 233</td>
</tr>
<tr>
<td>POS (Place of Service)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = ‘LU’</td>
</tr>
<tr>
<td>PD-NOS (Paid Number of Services)</td>
<td>2110</td>
<td>SVC05</td>
<td></td>
</tr>
<tr>
<td>PD-PROC (Procedure code – paid and if down-coded then the original procedure appears under SUB-PROC.)</td>
<td>2110</td>
<td>SVC01-2</td>
<td>SVC01-1 = ‘HC’ or ‘N4’</td>
</tr>
<tr>
<td>MODS (Procedure Code Modifiers)</td>
<td>2110</td>
<td>SVC01-3, SVC01-4, SVC01-5, SVC01-6</td>
<td>SVC01-1 = ‘HC’ or ‘N4’</td>
</tr>
<tr>
<td>BILLED (Billed Amount)</td>
<td>2110</td>
<td>SVC02</td>
<td></td>
</tr>
<tr>
<td>ALLOWED (Allowed Amount)</td>
<td>2110</td>
<td>AMT02</td>
<td>AMT01 = ‘B6’</td>
</tr>
<tr>
<td>DEDUCT (Deductible Amount)</td>
<td>2110</td>
<td>CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
<td>CAS01 = 'PR' &amp; (CAS02 = '1' or CAS05 = '1' or CAS08 = '1' or CAS11 = '1' or CAS14 = '1' or CAS17 = '1')</td>
</tr>
<tr>
<td>COINS (Coinsurance Amount)</td>
<td>2110</td>
<td>CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
<td>CAS01 = 'PR' &amp; (CAS02 = '2' or CAS05 = '2' or CAS08 = '2' or CAS11 = '2' or CAS14 = '2' or CAS17 = '2')</td>
</tr>
<tr>
<td>Remittance Advice Field</td>
<td>835 Loop ID</td>
<td>835 Segment Field</td>
<td>Identification/Comments</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GRP/CARC (Group/Claim Adjustment Reason Code)</td>
<td>2110</td>
<td>CAS01-CAS02, CAS05, CAS08, CAS11, CAS14, CAS17</td>
<td>Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 ‘1’ or ‘2’)); hard-code dash between group code and reason code</td>
</tr>
<tr>
<td>CARC-AMT (Claim Adjustment Reason Code Amount)</td>
<td>2110</td>
<td>CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
<td>Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 ‘1’ or ‘2’))</td>
</tr>
<tr>
<td>ADJ-QTY (Adjustment Quantity)</td>
<td>2110</td>
<td>CAS04 or CAS07 or CAS10 or CAS13 or CAS16 or CAS19</td>
<td>Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 ‘1’ or ‘2’))</td>
</tr>
<tr>
<td>BS (CAQH CORE-defined Business Scenario)</td>
<td></td>
<td></td>
<td>Based on the CARC</td>
</tr>
<tr>
<td>PROV-PD (Provider Paid Amount)</td>
<td>2110</td>
<td>SVC03</td>
<td></td>
</tr>
<tr>
<td>SUB-NOS: (Submitted Number of Services)</td>
<td>2110</td>
<td>SVC07</td>
<td>If paid units of service (SVC05) do not equal submitted units of service</td>
</tr>
<tr>
<td>SUB-PROC (Submitted Procedure Code)</td>
<td>2110</td>
<td>SVC06-2, SVC06-3, SVC06-4, SVC06-5, SVC06-6</td>
<td></td>
</tr>
<tr>
<td>RARC (Line Level Remark Codes)</td>
<td>2110</td>
<td>LQ02</td>
<td>LQ01 = ‘HE’</td>
</tr>
<tr>
<td>* CNTL #: (Line Item Control Number)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = ‘6R’</td>
</tr>
<tr>
<td>* HCPI: (HealthCare Policy Information)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = ‘0K’ (zero K)</td>
</tr>
<tr>
<td>PT RESP (Patient Responsibility)</td>
<td>2100</td>
<td>CLP05</td>
<td>Sum of all lines CAS monetary amounts, except those associated with adjustment reason codes ‘1’ and ‘2’ (Group code PR)</td>
</tr>
<tr>
<td>CARC (Total of all Claim Adjustment Reason Code amounts)</td>
<td>2110</td>
<td>LQ02</td>
<td>Sum of all lines CAS monetary amounts, except those associated with adjustment reason codes ‘1’ and ‘2’ (Group code PR)</td>
</tr>
<tr>
<td>CLAIM TOTALS (Billed Amount)</td>
<td>2100</td>
<td>CLP03</td>
<td>Sum of all lines AMT02, when AMT01 = ‘B6’</td>
</tr>
<tr>
<td>CLAIM TOTALS (Allowed Amount)</td>
<td></td>
<td></td>
<td>Sum of all lines CAS monetary amounts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘1’</td>
</tr>
<tr>
<td>CLAIM TOTALS (Deductible Amount)</td>
<td></td>
<td></td>
<td>Sum of all lines CAS monetary amounts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘2’</td>
</tr>
<tr>
<td>CLAIM TOTALS (Coinsurance Amount)</td>
<td></td>
<td></td>
<td>Sum of all lines CAS monetary amounts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘2’</td>
</tr>
<tr>
<td>Remittance Advice Field</td>
<td>835 Loop ID</td>
<td>835 Segment Field</td>
<td>Identification/Comments</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CLAIM TOTALS (Provider Paid Amount)</td>
<td>2100</td>
<td>CLP04</td>
<td></td>
</tr>
<tr>
<td>ADJ TO TOTALS: PREV PD (Adjustment to Totals: Previous Paid Amount)</td>
<td>2100</td>
<td>AMT02</td>
<td>Not available</td>
</tr>
<tr>
<td>ADJ TO TOTALS: INTEREST (Adjustment to Totals: Interest Amount)</td>
<td>2100</td>
<td>AMT02</td>
<td>Claim level AMT01 = ‘I’</td>
</tr>
<tr>
<td>ADJ TO TOTALS: LATE FILING CHARGE (Adjustment to Totals: Late Filing Charge)</td>
<td>2110</td>
<td></td>
<td>Sum of all line level AMT02, when AMT01 = ‘KH’</td>
</tr>
<tr>
<td>NET</td>
<td></td>
<td></td>
<td>Sum of all the line level provider paid amts plus adj to totals: interest minus adj to totals: late filing charge</td>
</tr>
<tr>
<td>GRP/CARC (Group Code/Claim Adjustment Reason Code)</td>
<td>2100</td>
<td>CAS01–CAS02, CAS05, CAS08, CAS11, CAS14, CAS17</td>
<td>Do not print CAS01–CAS02, CAS05, CAS08, CAS11, CAS14, CAS17</td>
</tr>
<tr>
<td>CARC-AMT (Claim Adjustment Reason Code Amount)</td>
<td>2100</td>
<td>CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
<td>Do not print CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
</tr>
<tr>
<td>BS (CAQH CORE-defined Business Scenario)</td>
<td></td>
<td></td>
<td>Based on the CARC</td>
</tr>
<tr>
<td>CLAIM INFORMATION FORWARDED TO:</td>
<td>2100</td>
<td></td>
<td>NM101 = ‘TT’</td>
</tr>
<tr>
<td>(Crossover Carrier Name)</td>
<td></td>
<td>NM103</td>
<td>NM102 = ‘2’</td>
</tr>
<tr>
<td>* (Crossover Carrier Identifier)</td>
<td></td>
<td>NM109</td>
<td>NM108 = ‘PI’ or ‘XV’</td>
</tr>
<tr>
<td>* CORRECTED PRIORITY PAYER INFO:</td>
<td>2100</td>
<td></td>
<td>NM101 = ‘PR’</td>
</tr>
<tr>
<td>* (Corrected Priority Payer Name)</td>
<td></td>
<td>NM103</td>
<td>NM102 = ‘2’</td>
</tr>
<tr>
<td>* (Corrected Priority Payer Identification Number)</td>
<td></td>
<td>NM109</td>
<td>NM108 = ‘PI’ or ‘XV’</td>
</tr>
<tr>
<td>TOTALS: # OF CLAIMS</td>
<td></td>
<td></td>
<td>Number of CLP segments within a LX</td>
</tr>
<tr>
<td>TOTALS: BILLED AMT (Total – Billed Amount)</td>
<td></td>
<td></td>
<td>Sum of CLP03</td>
</tr>
<tr>
<td>TOTALS: ALLOWED AMT (Total – Allowed Amount)</td>
<td></td>
<td></td>
<td>Sum of AMT02 when AMT01 = ‘B6’</td>
</tr>
<tr>
<td>TOTALS: DEDUCT AMT (Total – Deductible Amount)</td>
<td></td>
<td></td>
<td>Sum of CAS monetary amts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘1’</td>
</tr>
<tr>
<td>TOTALS: COINS AMT (Total – Coinsurance Amount)</td>
<td></td>
<td></td>
<td>Sum of CAS monetary amts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘2’</td>
</tr>
</tbody>
</table>
# Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk

## Remittance Advice Field

<table>
<thead>
<tr>
<th>Remittance Advice Field</th>
<th>835 Loop ID</th>
<th>835 Segment Field</th>
<th>Identification/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOTAL: CARC-AMT</td>
<td></td>
<td>835</td>
<td>Sum of CAS monetary amounts, excepting those associated with adjustment reason codes ‘1’ and ‘2’</td>
</tr>
<tr>
<td>(Total – Claim Adjustment Reason Code Amount)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTALS: PROV-PD AMT</td>
<td></td>
<td>835</td>
<td>Sum of CLP04</td>
</tr>
<tr>
<td>(Total – Provider Paid Amount)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTALS: PROV ADJ AMT</td>
<td></td>
<td>835</td>
<td>Sum of AMT02 when AMT01 = ‘B6’ and ‘KH’</td>
</tr>
<tr>
<td>(Total – Provider Adjustment Amount)</td>
<td></td>
<td></td>
<td>(The sum of the details (amount) in the PROVIDER ADJ DETAILS section.)</td>
</tr>
<tr>
<td>CHECK AMT</td>
<td>BPR02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Check Amount)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Provider Adjustment Details

<table>
<thead>
<tr>
<th>PLB REASON CODE</th>
<th>PLB03-1, PLB05-1, PLB07-1, PLB09-1, PLB11-1, PLB13-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCN/OTHER IDENTIFIER</td>
<td>Positions 1–50 of PLB03-2, PLB05-2, PLB07-2, PLB09-2, PLB11-2, PLB13-2</td>
</tr>
<tr>
<td>AMOUNT</td>
<td>PLB04, PLB06, PLB08, PLB10, PLB12, PLB14</td>
</tr>
</tbody>
</table>

### Summary of non-assigned claims

<p>| NAME (Patient Last Name)        | 2100 | NM103 | NM101 = ‘QC’ |
| NAME (Patient First Name)       | 2100 | NM104 | NM101 = ‘QC’ / NM102 = ‘1’ |
| NAME (Patient Middle Name)      | 2100 | NM105 | NM101 = ‘QC’ / NM102 = ‘1’ |
| MID (Patient ID)                | 2100 | NM109 | NM108 = ‘HN’ or ‘C’ |
| ACNT (Patient Account Number)   | 2100 | CLP01 |                                           |
| ICN (Claim Control Number)      |      | CLP07 |                                            |
| ASG (Claim Assignment)          | 2000 |       | Hard-coded ‘N’ for Medicare when LX01 = ‘0’ |
| MOA (Claim Level Remark Codes)  | 2100 | MOA03, MOA04, MOA05, MOA06, MOA07          |</p>
<table>
<thead>
<tr>
<th>Remittance Advice Field</th>
<th>835 Loop ID</th>
<th>835 Segment Field</th>
<th>Identification/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>REND PROV (Rendering Provider)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = HPI or REF01 = ‘1C’</td>
</tr>
<tr>
<td>2110</td>
<td>NM109 or REF02</td>
<td>NM108 = ‘XX’ or REF01 = ‘1C’</td>
<td></td>
</tr>
<tr>
<td>1000B</td>
<td>N104 or REF02 or spaces</td>
<td>N103 = ‘XX’ or REF01 = ‘XX’</td>
<td></td>
</tr>
<tr>
<td>SERV-DATE (From Service Date)</td>
<td>2110</td>
<td>DTM02</td>
<td>Line level DTM01 = ‘150’ or ‘472’ else Claim level DTM01 = ‘232’</td>
</tr>
<tr>
<td>SERV-DATE (To Service Date)</td>
<td>2110</td>
<td>DTM02</td>
<td>Line level DTM01 = ‘151’ or ‘472’ else Claim level DTM01 = ‘233’</td>
</tr>
<tr>
<td>POS (Place of Service)</td>
<td>2110</td>
<td>REF02</td>
<td>REF01 = ‘LU’</td>
</tr>
<tr>
<td>PD-NOS (Paid Number of Services)</td>
<td>2110</td>
<td>SVC05</td>
<td></td>
</tr>
<tr>
<td>PD-PROC (Procedure code – paid and if down-coded then the original procedure appears.)</td>
<td>2110</td>
<td>SVC01-2</td>
<td>SVC01-1 = ‘HC’ or ‘N4’</td>
</tr>
<tr>
<td>MODS (Procedure code modifiers)</td>
<td>2110</td>
<td>SVC01-3, SVC01-4, SVC01-5, SVC01-6</td>
<td>SVC01-1 = ‘HC’ or ‘N4’</td>
</tr>
<tr>
<td>BILLED (Billed Amount)</td>
<td>2110</td>
<td>SVC02</td>
<td></td>
</tr>
<tr>
<td>ALLOWED (Allowed Amount)</td>
<td>2110</td>
<td>AMT02</td>
<td>AMT01 = ‘B6’</td>
</tr>
</tbody>
</table>
| DEDUCT (Deductible Amount) | 2110 | CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18 | CAS01 = ‘PR’ & (CAS02 = ‘1’ or CAS05 = ‘1’ or CAS08 = ‘1’ or CAS11 = ‘1’ or CAS14 = ‘1’ or CAS17 = ‘1’)
| COINS (Coinsurance Amount) | 2110 | CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18 | CAS01 = ‘PR’ & (CAS02 = ‘2’ or CAS05 = ‘2’ or CAS08 = ‘2’ or CAS11 = ‘2’ or CAS14 = ‘2’ or CAS17 = ‘2’)
<p>| GRP/CARC (Group Code/Claim Adjustment Reason Code) | 2110 | CAS01-CAS02, CAS05, CAS08, CAS11, CAS14, CAS17 | Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 = ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 = ‘1’ or ‘2’)); hard-code dash between group code and reason code |
| CARC-AMT (Claim Adjustment Reason Code Amount) | 2110 | CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18 | Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 = ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 = ‘1’ or ‘2’)) |
| ADJ-QTY (Adjusted Quantity) | 2110 | CAS04 or CAS07 or CAS10 or CAS13 or CAS16 or CAS19 | Do not print CAS01 = ‘PR’ and ((CAS02 = ‘1’ or ‘2’) or (CAS05 = ‘1’ or ‘2’) or (CAS08 = ‘1’ or ‘2’) or (CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ or ‘2’) or (CAS17 = ‘1’ or ‘2’)) |
| BS (CAQH CORE-defined Business Scenario) | 2110 | | Based on the CARC |</p>
<table>
<thead>
<tr>
<th>Remittance Advice Field</th>
<th>835 Loop ID</th>
<th>835 Segment Field</th>
<th>Identification/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROV-PD (Provider Paid Amount)</td>
<td>2110</td>
<td>SVC03</td>
<td></td>
</tr>
<tr>
<td>SUB-NOS (Submitted Number of Services)</td>
<td>2110</td>
<td>SVC07</td>
<td>If paid units of service (SVC05) do not equal submitted units of service</td>
</tr>
<tr>
<td>SUB-PROC (Submitted procedure code)</td>
<td>2110</td>
<td>SVC06-2, SVC06-3, SVC06-4, SVC06-5, SVC06-6</td>
<td></td>
</tr>
<tr>
<td>RARC (Line Level Remark Codes)</td>
<td>2110</td>
<td>LQ02</td>
<td>LQ01 = ‘HE’</td>
</tr>
<tr>
<td>PT RESP (Patient Responsibility)</td>
<td>2100</td>
<td>CLP05</td>
<td></td>
</tr>
<tr>
<td>CARC (Total of all Claim Adjustment Reason Code amounts)</td>
<td>2100</td>
<td>CLP03</td>
<td>Sum of all lines CAS monetary amounts, except those associated with adjustment reason codes ‘1’ and ‘2’ (Group code PR)</td>
</tr>
<tr>
<td>CLAIM TOTAL (Billed Amount)</td>
<td>2100</td>
<td>CLP03</td>
<td>Sum of all lines AMT02, when AMT01 = B6.</td>
</tr>
<tr>
<td>CLAIM TOTAL (Allowed Amount)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLAIM TOTAL (Deductible Amount)</td>
<td></td>
<td></td>
<td>Sum of all lines CAS monetary amounts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘1’</td>
</tr>
<tr>
<td>CLAIM TOTAL (Coinsurance Amount)</td>
<td></td>
<td></td>
<td>Sum of all lines CAS monetary amounts, when CAS01 = ‘PR’ and the corresponding adjustment reason code equals ‘2’</td>
</tr>
<tr>
<td>CLAIM TOTAL (Provider Paid Amount)</td>
<td>2100</td>
<td>CLP04</td>
<td></td>
</tr>
<tr>
<td>ADJ TO TOTALS: PREV PD (Adjustment to Totals: Previous Paid Amount)</td>
<td>2100</td>
<td>AMT02</td>
<td>Claim level AMT01 = ‘I’</td>
</tr>
<tr>
<td>ADJ TO TOTALS: INTEREST (Adjustment to Totals: Interest Amount)</td>
<td>2100</td>
<td>AMT02</td>
<td>Sum of all line level AMT02, when AMT01 = ‘KH’</td>
</tr>
<tr>
<td>ADJ TO TOTALS: LATE FILING CHARGE (Adjustment to Totals: Late Filing Charge)</td>
<td>2110</td>
<td>AMT02</td>
<td>Sum of all the line level provider paid amts plus adj to totals: interest minus adj to totals: late filing charge</td>
</tr>
<tr>
<td>NET</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRP/CARC (Group Code/Claim Adjustment Reason Code)</td>
<td>2100</td>
<td>CAS01-CAS02, CAS05, CAS08, CAS11, CAS14, CAS17</td>
<td>Do not print CAS01-CAS02, CAS05, CAS08, CAS11, CAS14, CAS17</td>
</tr>
<tr>
<td>CARC-AMT (Claim Adjustment Reason Code Amount)</td>
<td>2100</td>
<td>CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
<td>Do not print CAS03 or CAS06 or CAS09 or CAS12 or CAS15 or CAS18</td>
</tr>
<tr>
<td>Remittance Advice Field</td>
<td>835 Loop ID</td>
<td>835 Segment Field</td>
<td>Identification/Comments</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>BS (CAQH CORE Code-defined Business Scenario)</td>
<td></td>
<td></td>
<td>Based on the CARC</td>
</tr>
<tr>
<td>CLAIM INFORMATION FORWARDED TO:</td>
<td>2100</td>
<td></td>
<td>NM101 = ‘TT’</td>
</tr>
<tr>
<td>* (Crossover Carrier Name)</td>
<td></td>
<td></td>
<td>NM102 = ‘2’</td>
</tr>
<tr>
<td>* (Crossover Carrier Identifier)</td>
<td></td>
<td></td>
<td>NM108 = ‘PI’ or ‘XV’</td>
</tr>
<tr>
<td>* CORRECTED PRIORITY PAYER INFO:</td>
<td>2100</td>
<td></td>
<td>NM101 = ‘PR’</td>
</tr>
<tr>
<td>* (Corrected Priority Payer Name)</td>
<td></td>
<td></td>
<td>NM102 = ‘2’</td>
</tr>
<tr>
<td>* (Corrected Priority Payer Identification Number)</td>
<td></td>
<td></td>
<td>NM108 = ‘PI’ or ‘XV’</td>
</tr>
<tr>
<td>GLOSSARY</td>
<td></td>
<td></td>
<td>MOA03, MOA04, MOA05, MOA06, MOA07, CAS01, CAS02, CAS05, CAS08, CAS11, CAS14, CAS17, BS</td>
</tr>
</tbody>
</table>
Appendix B: Abbreviation and Acronym Glossary

The following two column table provides the abbreviations or acronym values in the first column, and the second column contains the descriptions.

<table>
<thead>
<tr>
<th>Abbreviation or Acronym Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACNT</td>
<td>Account</td>
</tr>
<tr>
<td>ADJ</td>
<td>Adjustment</td>
</tr>
<tr>
<td>ADJ-QTY</td>
<td>Adjustment Quantity</td>
</tr>
<tr>
<td>Adjst</td>
<td>Adjustment</td>
</tr>
<tr>
<td>AMT</td>
<td>Amount</td>
</tr>
<tr>
<td>ASG</td>
<td>Assignment of claim</td>
</tr>
<tr>
<td>Bene</td>
<td>Beneficiary</td>
</tr>
<tr>
<td>BS</td>
<td>CAQH CORE-defined Business Scenario</td>
</tr>
<tr>
<td>CARC</td>
<td>Claim Adjustment Reason Code</td>
</tr>
<tr>
<td>CARC-AMT</td>
<td>Claim Adjustment Reason Code Amount</td>
</tr>
<tr>
<td>CNTL#</td>
<td>Control Number</td>
</tr>
<tr>
<td>COB</td>
<td>Coordination of Benefits</td>
</tr>
<tr>
<td>COIN</td>
<td>Coinsurance</td>
</tr>
<tr>
<td>Coins</td>
<td>Coinsurance</td>
</tr>
<tr>
<td>Deduct</td>
<td>Deductible</td>
</tr>
<tr>
<td>DMERC</td>
<td>Durable Medical Equipment Resource Center</td>
</tr>
<tr>
<td>ERA</td>
<td>Electronic Remittance Advice</td>
</tr>
<tr>
<td>EFT</td>
<td>Electronic Funds Transfer</td>
</tr>
<tr>
<td>GRP/CARC</td>
<td>Group and Claim Adjustment Reason Codes</td>
</tr>
<tr>
<td>HCPCS</td>
<td>Health Care Procedure Codes</td>
</tr>
<tr>
<td>HCPI</td>
<td>Health Care Policy Information</td>
</tr>
<tr>
<td>HIC</td>
<td>Health Insurance Claim Number</td>
</tr>
<tr>
<td>HICN</td>
<td>Health Insurance Claim Number</td>
</tr>
<tr>
<td>HIPAA</td>
<td>Health Insurance Portability and Accountability Act</td>
</tr>
<tr>
<td>ID</td>
<td>Identifier</td>
</tr>
<tr>
<td>Abbreviation or Acronym Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>ICN</td>
<td>Internal Control Number</td>
</tr>
<tr>
<td>MID</td>
<td>Medicare Identification Number</td>
</tr>
<tr>
<td>MOA</td>
<td>Medicare Outpatient Adjudication</td>
</tr>
<tr>
<td>MODS</td>
<td>Modifiers</td>
</tr>
<tr>
<td>MREP</td>
<td>Medicare Remit Easy Print</td>
</tr>
<tr>
<td>MSP</td>
<td>Medicare Secondary Payer</td>
</tr>
<tr>
<td>NDC</td>
<td>National Drug Code</td>
</tr>
<tr>
<td>NPI</td>
<td>National Provider Identifier</td>
</tr>
<tr>
<td>NOS</td>
<td>Number of Services</td>
</tr>
<tr>
<td>Orig</td>
<td>Original</td>
</tr>
<tr>
<td>PD-NOS</td>
<td>Number of Services – Paid</td>
</tr>
<tr>
<td>PD-PROC</td>
<td>Procedure Code – Paid</td>
</tr>
<tr>
<td>PHI</td>
<td>Personal Health Information</td>
</tr>
<tr>
<td>PLB</td>
<td>Provider Level Balancing</td>
</tr>
<tr>
<td>POS</td>
<td>Place of Service</td>
</tr>
<tr>
<td>PREV PD</td>
<td>Previous Paid</td>
</tr>
<tr>
<td>PROC</td>
<td>Procedure Code</td>
</tr>
<tr>
<td>PROV</td>
<td>Provider</td>
</tr>
<tr>
<td>PROV-PD</td>
<td>Provider Paid</td>
</tr>
<tr>
<td>PT RESP</td>
<td>Patient Responsibility</td>
</tr>
<tr>
<td>RARC</td>
<td>Remittance Advice Remark Code</td>
</tr>
<tr>
<td>Remit</td>
<td>Remittance Advice</td>
</tr>
<tr>
<td>REND-PROV</td>
<td>Rendering Provider</td>
</tr>
<tr>
<td>SERV-DATE</td>
<td>Service Dates</td>
</tr>
<tr>
<td>SPR</td>
<td>Standard Paper Remittance advice</td>
</tr>
<tr>
<td>SUB-NOS</td>
<td>Submitted Number of Services</td>
</tr>
<tr>
<td>SUB-PROC</td>
<td>Submitted HCPCS Procedure Code</td>
</tr>
<tr>
<td>ZIP</td>
<td>ZIP Code</td>
</tr>
</tbody>
</table>